Part 1: Introduction to ModelBuilder
	ModelBuilder Help
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What is ModelBuilder?
Find out what ModelBuilder does and how it can help you 

Quick Start Tutorial
Teach yourself how to use ModelBuilder with these hands-on exercises 

Working with ModelBuilder
Learn how to build, save, run and revise a model 

Model Processes
Learn how to build processes using wizards and property sheets 

Glossary
Look up common GIS and ModelBuilder terms 

1.1 What is ModelBuilder?
ModelBuilderTM is a tool in the ArcView Spatial Analyst extension that helps you create a spatial model of a geographic area. A spatial model records the processes, such as buffering or overlaying themes, required to convert input data into an output map. Large models can be built by connecting several processes together. 

In ModelBuilder, a spatial model is represented as a diagram that looks like a flow chart (see the illustration below). It has nodes representing input data, spatial functions that do the processing, and output data. It has arrows connecting the nodes that show the sequence of processing in the model. The model is much more than a static diagram; it stores all the properties and instructions necessary to run the model in ArcView. You can also create documentation that is saved as part the model. This makes the model reusable and shareable with others. You can apply the same model to different geographic areas by changing the input data. You can easily modify the model to explore "what if" scenarios and obtain different solutions. 

ModelBuilder has the tools you need to create, modify, and run a model. ModelBuilder uses ArcView to manage the input and output data. In most cases, you add the input data as a theme in ArcView. From ArcView, you start the ModelBuilder window and load an existing model or create a new model. When you run the model, the output data is created and displayed in your ArcView project. 

Some features of ModelBuilder include: 

· A window where you build and save your models 

· Wizards that walk you through adding new processes or editing the properties of existing processes 

· Property sheets that let you quickly modify properties of input data, processes, or output data. 

· Drag-and-drop tools that let you build and connect processes manually 

· Layout tools that help you arrange your model neatly 

Here is an example of how a model appears in the ModelBuilder window. The rectangles represent input data; the ovals represent functions that process the input data; the rounded rectangles represent output data that is created when the model is run. 
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1.2 How ModelBuilder helps you do spatial analysis
A spatial analysis is the process you go through to discover and understand spatial relationships in your data. An example of a spatial analysis is a site suitability study. You might be planning to open a new store, so you study the sites under consideration to determine if there is affordable real estate, good demographics, and few competitors nearby. By rating each site on all these factors, you determine the most and least favorable sites. When you combine several geographic factors, this type of spatial analysis is called overlay. If you did this analysis manually, you would create several maps on paper, then overlay them and pick the best sites visually. 

ModelBuilder helps you by capturing your spatial analysis in a model. Because the processing sequence is saved and documented, your spatial analysis becomes automated and reusable. You could create a site suitability model in ModelBuilder that automatically determines the best sites for your new store. Your model contains a process that overlays the real estate costs, demographics, and proximity of competitors. When you run the model, it gives each site a suitability rating based on all these factors. When you want to open another store, you can reuse the model without rebuilding it. If you have documented it well, you have a record of the assumptions you made in the model. Your model might look like the illustration below. 
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You can modify your model to explore different solutions. If you decide that you need to consider street access to your store, you could add street accessibility to the overlay process without rebuilding the entire model. If you set the acceptable real estate cost too low, the model might not find any acceptable sites in the area. You can easily change the properties of your model so that the acceptable real estate cost is more realistic. Your modified model might look like the illustration below. 
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Because the ModelBuilder displays a model graphically, it is easier for someone else to understand how you did your spatial analysis. When applying for a loan for your new store, you could show investors your site suitability model to explain how you did your research and why your store has a high probability of success. 

You could use ModelBuilder in a wide variety of spatial analyses. With ModelBuilder, you can create slope and aspect maps from elevation data, then overlay them with rainfall and soil type data to create an erosion hazard map. You could create buffer zones around airports showing noise levels. You can create contour maps, and hillshade maps that give a three-dimensional illusion. You could create a model that predicts population growth of a city based on birth rates, housing construction, and job availability. You could do "what if" scenarios by changing the job availability factor based on different economic predictions. 

1.3 Starting ModelBuilder
To start ModelBuilder, you must have the Spatial Analyst and ModelBuilder extensions turned on in ArcView. You can access the Extensions popup window by selecting Extensions from the File menu in ArcView. 
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When you turn on these extensions, the Model menu is added to the view interface in ArcView. From the Model menu, select Start ModelBuilder. 
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A ModelBuilder window opens. You can begin creating your model in this window. 
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The ModelBuilder window is independent of the ArcView window, but it depends on ArcView to display input and output data. You use the ModelBuilder window to build your model. If your model uses themes as input data, the themes must be in the current ArcView project before the model can run. After the model runs, output data displays as a new theme in ArcView. 

Before you begin building a model, you might want to set the default properties for the model and the default process settings. For more information, see Setting model defaults and documentation. 

To begin building a model you add processes to the model using wizards or drag-and-drop tools. To learn more about the processes available and how to implement them, see Model Processes. 

	1.4 Modeling basics
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To learn how to use ModelBuilder effectively, you should understand what a model is, what a process is, and how to build a model by adding and connecting processes. The diagram below shows a model that contains three processes. The processes are represented in a model by nodes and connectors. Nodes that represent input data that can be project data or derived data, depending on whether the data is added outside the model or created within the model. A process also has a function node that represents the operation performed by the process, and a derived data node that represents the output created by the process. The connectors are lines that connect the nodes and show the flow of data through a model. The output from one process can become the input for another process. 
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	1.4.1 What is a model?


A model is a representation of reality. The purpose of creating a model is to help understand, describe, or predict how things work in the real world by exploring a simplified version of a feature or phenomenon. A spatial model consists of a collection of processes performed on spatial data that will produce information, usually in the form of a map. You can use this information for decision making, scientific study, and to provide general information. 

When you create a model, you need to know what information (maps) the model should provide, what data is required, and how you will need to transform that data to produce the desired result. 

A model is represented in ModelBuilder as a diagram that shows the sequence of processing of input data. The ModelBuilder allows you to record the processing in a flow chart format. 

To build a model in ModelBuilder, you add and connect processes. A model can be simple or complex, depending on the number of input data sets and interrelated processes. An example of a very simple model would be one that generates a slope map from an elevation theme. The model consists of an input theme, called Elevation, a function called Slope, and an output theme, which is the Slope map. Connector lines with arrows indicate the flow of processing through the model. 
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Adding a few processes can make this model more complex. For example, the model shown below has two parallel processes that share the same input data. The model generates two output themes, Aspect and Slope. 
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For additional functionality, you can chain processes. The output theme of one process becomes the input theme to subsequent processes. Suppose a model creates a contour theme. The input data consists of a theme of elevation sample points. To generate the required contour data, two processes are needed. The first process creates an elevation theme from the sample points. The second process uses the output theme of the first process as its input and applies a function called Contour to produce the Contour Map output theme. 
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Building parallel and chained processes creates more comprehensive models as shown in the following illustration. This model creates a housing suitability map. First, buffer zones are created around schools (the Buffer Process) to find residential areas close to schools. Next, property values are reclassified into affordable and non-affordable ranges (the Reclass process). Finally, the school buffer and property value themes are combined with crime and zoning themes (the Weighted Overlay Process) to create the housing suitability map. 
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A model created in ModelBuilder is more than a graphical representation. The model stores information about the input data, processes, and output data in a text file. The ModelBuilder also allows you to incorporate comments, assumptions, citations, and web links directly into the model. Models are easy to reuse, modify, standardize, and share with others. 

	1.4.2 What is a process?
	


A process represents a single spatial operation on a data set, such as buffering a stream or hillshading an elevation map. Each process includes input data, the function performed on it, and output data. The output data is referred to as derived data because it is derived from the process. 

In the illustration below, a Buffer Process is represented by three nodes. The rectangle represents input data, the oval represents the function applied to the input data, and the rounded rectangle represents the derived data created by the function. The arrows between the nodess indicate the flow of data in and out of the function. 
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You can add a process to a model using a wizard, which automatically creates the process in the model window, or you can use the drag-and-drop tools to manually create a process, then define its properties using property sheets. 

There are two types of input data. Input data can be data in your current ArcView project, called project data, or it can be derived data from another process. Project data is represented by a rectangle, and derived data is represented by a rounded rectangle. Different processes can share the same input data, and some processes can have more than one input data source. 

In the illustration below, the model has two processes. The Point Interpolation Process reads project data (Elevation Points), applies the Point Interpolation function to it, and produces derived data (Elevation Surface). The Contour Process uses derived data (Elevation Surface) as input data, then processes it using the Contour function, and creates the Contour Map theme as derived data. The Elevation Points theme must be in the current ArcView project before the model is run. The Elevation Surface and Contour Map themes will be created in the view after the model runs. 
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Each process can only accept certain types of input data. For example, the Point Interpolation Process can only accept an ArcView point theme. The Slope Process can only accept a continuous grid theme. ModelBuilder helps you by identifying the input types that are valid for a given process. For more details, see Connecting and disconnecting processes. 

	1.4.3 Determining process status
	


The nodes that make up a process indicate the status of the process (not ready to run, ready to run, has been run). The status is indicated by the symbology of the node, such as its color and the presence or absence of a shadow. Below is a description of the default symbology. You can change the default symbology by selecting Layout Symbols from the View menu. 

A process is not ready to run when it is undefined or does not have all properties set. One or more of the nodes will be white (unless you have changed the default symbols). The process cannot run until you provide the missing information using a wizard or property sheet. 
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A process will become ready to run when you have provided all required property settings. You may see cases where some of the nodes for a process are ready to run and some are not. The process is not ready to run until all its nodes are ready to run. By default, project data nodes that are ready to run are blue, function nodes are yellow, and derived data nodes are green. 
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If a process has been run, each of its nodes will have a drop shadow (unless you have changed the symbology). If you change a process that has already been run, it will revert to ready to run status. 
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1.4.4 What processes are available?
In this release, ModelBuilder supports eleven processes. The processes have been organized in the five categories listed below. To learn more about a particular process, click on its name. 

Data Conversion category 

Vector Conversion Process (Vector to Grid) 

The Vector Conversion Process converts a point, line, or polygon vector theme to a grid theme. The resulting grid theme can be used as input to other processs such as Reclassification, Buffer, or Weighted Overlay. 

DEM Conversion Process (DEM to Grid) 

The DEM Conversion Process converts a standard USGS DEM file into a grid theme. DEM files are read from your disk drive because they cannot be added into ArcView directly. 

Point Interpolation Process 

The Point Interpolation Process creates a continuous grid theme that represents a surface by interpolating the measured values in a point theme. This process is often used to create an elevation surface grid theme from measured elevation points. The grid theme is commonly used as input to the Terrain, Reclassification, and Arithmetic Overlay Processes. 

Terrain category 

Slope Process 

The Slope Process creates a grid theme containing the slope in either percent or degrees. The slope is the rate of change in values (usually elevation values). The Slope Process requires a grid theme as input. 

Aspect Process 

The Aspect Process creates a grid theme containing the aspect, or compass direction of the downhill slope, in each cell of the grid theme. The input for this process is also a grid theme, usually an elevation theme. 

Hillshade Process 

The Hillshade Process creates a grid theme that shows the illumination of a surface in shaded relief. This process requires a grid theme as input, usually an elevation grid theme. 

Contour Process 

The Contour Process creates a series of contour lines from an input grid theme. The output is a vector theme of contour lines. 

Reclassification category 

Reclassification Process 

The Reclassification Process can be used to group the values of an input grid theme to new values in a discrete grid theme. For example, the land costs in a theme could be grouped into high, medium, and low price ranges in the output theme. The Reclassification Process is often used to convert continuous grid themes so they can be used in processes that require discrete grid themes as input, such as Weighted Overlay. 

Buffer category 

Buffer Process 

The Buffer Process allows you to create one or more buffers zones around features in an input theme. Each of these zones can be of equal or unequal width. The Process requires a discrete grid theme as input and creates one as output. The resulting theme can be used as input to the Overlay Processes. 

Overlay category 

Arithmetic Overlay Process 

The Arithmetic Overlay Process is used to add, subtract, multiply, or divide multiple factors on a geographic area. Each factor you wish to include in this overlay must be a grid theme. The result is a continuous grid theme. For example, you might use Arithmetic Overlay to add various costs together, such as land cost, construction costs, and utility costs. You might also use it to subtract one area from another. For example, you might subtract an area already inside a national park from a proposed conservation area. 

Weighted Overlay Process 

The Weighted Overlay Process creates a discrete grid theme that combines multiple input themes. The output theme represents the weighted influence of multiple features in a geographic area. Each of the input themes is assigned a percent influence based on its importance. Values within the themes are reassigned to a common evaluation scale. This allows unlike measurements, such as temperature and rainfall, to be converted to common values that can be added. This process is often used in site suitability studies where several factors affect the suitability of a site. 

Part 2: Quick start tutorials
In this tutorial, you will work through two step-by-step exercises to learn the basics of creating processes and models using ModelBuilder. In the first exercise, you will create an erosion hazard model to identify areas that are highly susceptible to erosion. In the second exercise, you will develop a housing suitability model that locates desirable neighborhoods according to specified criteria. 

Before starting this tutorial, you should be familiar with the ArcView GIS interface and basic ArcView GIS terminology. Each exercise is designed to take about an hour to complete, but the actual time it takes you will depend on your personal learning style. It is recommended that you finish an entire exercise in a single session; if you are unable to do this, try to complete a task that involves saving your work. 

If you would like to learn more about models before you start this tutorial, see What is a model? 

· Exercise 1: Erosion hazard modeling 

· Exercise 2: Housing suitability modeling 

Disclaimer: This agregated data used herein has been derived from actual statistical information. ESRI has manipulated and applied certain assumptions to it solely for educational training purposes. Assumptions applied and actual outcomes may vary. ESRI is not inviting reliance on this data, and the user should always verify actual data and exercise their own professional judgment when interpreting any outcomes. 

2.1 Exercise 1: Erosion hazard modeling

In this exercise, your task is to create an erosion hazard model that identifies areas at high risk for soil erosion. 

The model will involve several processes. First, you will convert vector-based soil and vegetation data into grid format. Then you will assign an erosion risk value to each soil type, each vegetation type, and to each range of terrain slope values. You will give a percentage influence to each factor - soil, vegetation, and slope. The percentage influence determines the relative importance, or weight, of the factor to the model. Finally, you will run the model to create an overall erosion hazard map. 

In this exercise you will learn: 

· How to set up the modeling environment 

· How to create processes 

· How to connect processes into a model 

· How to save and run a model 

· How to modify a model 

Task 1: Start ArcView and create a new view
The model works with a view containing the input and output data. Set the map units to meters so that the model's output data will be in the same units as the input data. 

1. Start ArcView GIS. 

2. If your screen displays the Welcome to ArcView GIS dialog box, click the option to create a new project with a new view and click OK. Otherwise, close any open projects, then click the File menu and click New Project. In the Untitled project window, make sure the Views icon is selected. Click the New button to create a new view. 
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3. Click No if you are prompted to add data to the view. 

4. Click the View menu and click Properties. 
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5. In the View Properties dialog box, click the Map Units dropdown arrow and click meters. Click the Distance Units dropdown arrow and again click meters. Click OK. 
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Task 2: Add the soils grid theme and legend
The Soilsgrid theme is a grid theme that you will add to the view so you can use it in your model. The erosion hazard model will assign higher erosion potential to loosely compacted soils and lower erosion potential to bedrock and tightly compacted soils. 

1. Click the Add Theme button. 

2. Navigate to the location of the av_gis30\avtutor\spatial\model\exercise1 folder. For example, the complete pathname might be c:\esri\av_gis30\avtutor\spatial\model\exercise1. 

3. Click Data Source Types dropdown arrow and click Grid Data Source. 

4. Click soilsgrid and click OK to add the grid theme to the view. 
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Now you will load a predefined legend that defines the soil types in the Soilsgrid theme. 

5. Double-click Soilsgrid in the View1 Table of Contents to open the Legend Editor. 

6. Click Load. In the Load Legend dialog box, click soilsgrid.avl. Click OK. 

7. Click OK in the Load Legend popup window. Click Apply in the Legend Editor and close the Legend Editor. 

8. Click the check box of the Soilsgrid theme to turn it on. 
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Task 3: Add the vegetation and study area themes

The vegetation theme is a shapefile that you will use in your model. The erosion hazard model will assign higher erosion potential to barren areas or areas with shallow-rooted vegetation. Lower erosion potential will be assigned to thick, deep-rooted, vegetation. 

The study area theme is a shapefile containing a rectangle polygon. The study area theme will limit the extent of the output themes created by your erosion model. 

1. Click the Add Theme button [image: image27]. 

2. If necessary, navigate to the av_gis30\avtutor\spatial\model\exercise1 folder. 

3. Click the Data Source Types dropown arrow and click Feature Data Source. 

4. Click studyarea.shp. Hold down the Shift key and click vegetation.shp. Click OK. 

The themes are added to the Table of Contents. 

5. In the View1 Table of Contents, click the Studyarea.shp theme and drag it to the top. Click the check boxes for Studyarea.shp and Vegetation.shp to draw them. 
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Task 4: Start ModelBuilder and set the model defaults

The ModelBuilder window is the work area where you will create the erosion hazard model. 

1. In ArcView GIS, click the Model menu and click Start ModelBuilder. 

2. In ModelBuilder, click the Model menu and click Model Defaults. 
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Default settings are automatically applied to all processes in a model. You can override them whenever you want. 

3. Make sure the Extent tab is selected. Click the option to set the extent of the output theme to the extent of this theme. Click the dropdown arrow and click Studyarea.shp. 
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The model will use this theme as the extent for all output themes, unless you specify a different extent. 

4. Click the Cell Size tab. Click the last button to specify an output cell size. Type "30" in the textbox and click OK. 
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The model will create new themes with a cell size of 30 meters, unless you specify otherwise. The cell size is in meters because you set the map units to meters in the first task.

Task 5: Add a DEM to Grid Data Conversion Process
In ModelBuilder, you will use the DEM to Grid Conversion Process to create an elevation grid theme from a DEM file. This elevation grid theme will be used to calculate slope data. 

1. Click the Add Process menu, point to Data Conversion, and click DEM to Grid. The DEM Conversion wizard opens. Read the introductory panel and click Next to continue. 

2. Click the Browse button and navigate to the av_gis30\avtutor\spatial\model\exercise1 folder. Click the elevation.dem file and click Open. The wizard displays the DEM file selection. Click Next to continue. 
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The next part of the wizard asks you to define the properties of the output grid theme. The legend table determines how values in the output theme will be grouped in the output theme legend. You will accept the default legend. 

3. Click Next in the legend table panel. 

4. In the color scheme panel, click Green Monochromatic. This color ramp will be applied to the values in the output theme. Click Next. 

[image: image33.png]Red Manochnaic

[T rr——

Chatieus Moncchiomatc

Gimen Movochanaic

-

Choose the color scheme forthe outpu theme.

Bekon i the oo scheme forth okt theme.To change l e
cir, ek on ok cheme e st el o change
il ok e Sk o 1 Ll o,
Labal Colr
281 206
2526182
w2216
5025754
EEE]

oot | ok | wews | |





5. In Task 4, you specified that Studyarea.shp be used as the default extent for this model. The extent panel is automatically set to this theme. Click Next. 

6. Also in Task 4, you specified a default cell size of 30 meters for the model. Click Next on the cell size panel to accept the default. 

7. The documentation panel is for providing additional information about the model. In the Comments text box, type, "This process converts DEM data to an elevation grid that will later be converted to slope data." Click Next on the documentation panel. 

8. Type "Elevation Grid" for the theme name and type "elevgrd" for the file name. This will be the name of the output file on disk. Click Finish. 

A DEM Conversion Process is added to the erosion hazard model. The process has nodes with property sheets that allow you to access the process properties you entered in the wizard. Note that the process does not run or create the grid theme after you exit the wizard. 
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Task 6: Save the model
1. In ModelBuilder, click the File menu and click Save. Navigate to the folder where you want to save the model (for example, C:\temp). In the Model name text box, type "Exercise1". Click OK. 
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Task 7: Add a process using the drag-and-drop method

The vegetation shapefile must be converted to grid format so it can be overlaid with the elevation grid theme and the soils grid theme. You will add a Vector Conversion Process to the model to do the conversion. 

Previously, you added a process using a wizard. Another way to create a process is to drag and drop nodes in the model window, then define their properties using property sheets. Property sheets look like wizard panels, but they are not sequential. You can do them in any order. 

1. On the ModelBuilder toolbar, click the Add Data [image: image36.png]


 button and click anywhere inside the model window. 

A project data node, called "Data", appears in the model. You will use this node's property sheet to enter information about the input theme. (Don't worry about placement of the nodes; you can rearrange them later.) 
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2. Click the Add Function [image: image38.png]


 button and click inside the model window. 

An oval function node appears in the model, representing the spatial operation that will be applied to the input data. It has a connected derived data node ("Derived Data") that represents the output theme created by the process. 
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3. Click the Add Connection [image: image40.png]


 button. Drag a line between the project data and function nodes. 
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4. Click the Auto Layout [image: image42.png]


 button to arrange the layout. If necessary, click the Full View [image: image43.png]


 button to make the model fit in the window. 

You have just created a process using the ModelBuilder drag-and-drop tools. You will define the properties of this process in the next task.
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Task 8: Define the Vector Conversion Process and its properties
Next, you define the process as a Vector Conversion Process and specify that the input data is the vegetation shapefile. 

1. Right-click on the Data node and click Theme. The project data node changes from an undefined data node to a theme node. 

2. Right-click on the Theme node and click Properties. The Project Theme property sheet opens. In the project data name text box, type "Vegetation". Click the input theme dropdown arrow and click Vegetation.shp. Click the input field dropdown arrow and click VegType. Click OK. 
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The name of the project data node changes from Theme to Vegetation. 
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3. Right-click on the Function node, point to Data Conversion, and click Vector to Grid. The undefined function changes to a Vector Conversion function and the name of the derived data changes to Vector Conversion Map. 
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4. Right-click the Vector Conversion node and click Properties. In the output grid, each cell corresponding to a particular vegetation type stores the associated New Class Value. Click OK. 
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5. Right-click the Vector Conversion Map node and click Properties. 

6. The Output Theme tab is selected. In the theme name text box, type "Vegetation Grid". In the file name text box, type "veggrid". Click OK. 
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7. Click Save. 

You have defined the Vector Conversion Process that will create a grid theme from the vegetation shapefile. Next, you'll create a Slope Process. 
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Task 9: Create a Slope Process using the drag-and-drop method
Slope, the rate of change of elevation, affects the erosion potential of an area. Elevation data can be used to derive slope data. The Elevation Grid output theme from the DEM Conversion Process can be used as the input theme to the Slope Process. 

1. Click the Zoom Out [image: image51.png]bYd
b



 button once to make room for a new process. 

2. Click the Add Function [image: image52.png]


 button and click inside the model window. 

A function node and its connected derived data node appear in the model. 

3. Right-click the Function node, point to Terrain, and click Slope. The function name changes to Slope and the derived data name changes to Slope Map. 
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Task 10: Define the properties of the Slope Process using the wizard

You will use the Slope Wizard to define the properties of the Slope Process. The input data is the Elevation Grid output from the DEM Conversion Process. The wizard will automatically connect the Slope and DEM Conversion Processes. 

1. Right-click on the Slope node and click Wizard. Read the introductory panel and click Next. 

2. On the input theme panel, make sure that Elevation Grid is the selected input theme. Click Next. 

3. On the method panel, make sure Degrees is selected. Click Next. 

4. On the discrete or continuous panel, click the option to create a discrete grid theme. The slope data will be used in a Weighted Overlay Process that requires discrete grid themes. Click Next. 

5. The classification table panel shows you how slope values will be grouped into classes in the output theme. Click Next. 

6. On the color scheme panel, the default color scheme is red monochromatic. Click Next. 

7. On the extent panel, the extent is set to Studyarea.shp. (This is the model default you specified in Task 4.) Click Next. 

8. On the cell size panel, the cell size is 30 meters. This again is the model default you specified. Click Next. 

9. On the documentation panel, the Comments tab is selected. Click in the text box and type "This process converts elevation data into slope data." Click Next. 

10. On the output theme panel, click in the theme name text box and type "Slope Grid". Leave the filename as "slopegrid1". 

11. Click Finish to exit the wizard. Click the Full View [image: image54.png]


 button. 

The Slope function is automatically connected to its input data, Elevation Grid. you are ready to combine the vegetation and slope data with the soils data in a Weighted Overlay Process.
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Task 11: Start the Weighted Overlay Wizard and define the erosion hazard scale
The Weighted Overlay Process combines the slope, vegetation, and soils data to assess the overall erosion hazard. To overlay themes that do not contain similar data, such as soils and vegetation, you have to convert the values in each theme to a common evaluation scale before weighting and adding them. In this case, the scale is an erosion hazard scale, with 1 being the lowest erosion potential, and 9 the highest. 

Task 12: Add the themes to be overlaid

1. Click the Add Process menu, point to Overlay, and click Weighted Overlay. Read the introductory panel and Click Next. 

2. On the evaluation scale panel, the predefined evaluation scale is set to 1 to 9. This is the evaluation scale you will use. Click Next. 

The weighted overlay table is where you will define the input themes, their weights, and the scale values of each input in each theme. 

1. On the weighted overlay table panel, click Add Theme to open the Theme and Field dialog box. Click the input theme dropdown arrow and click Slope Grid. Leave the input field dropdown list set to Value, the field that contains the slope values. Click OK. 

The Slope Grid theme is added to the weighted overlay table. 
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2. On the weighted overlay panel, click Add Theme again. In the Theme and Field dialog box, click the input theme dropdown arrow and click Soilsgrid. Click the input field dropdown list and click S_value. Click OK. 

3. Scroll to the bottom of the weighted overlay table to see that the Soilsgrid theme has been added. 

4. Click Add Theme again. In the Theme and Field dialog box, click the input theme dropdown arrow and click Vegetation Grid. Leave the input field dropdown list set to Value. Click OK. 

5. Scroll to the bottom of the weighted overlay table to confirm that the Vegetation Grid theme has been added. 

Task 13: Set the influence factor for each theme
In the weighted overlay table, the Percent Influence field (%Inf) is used to assign the influence each theme has on the erosion hazard assessment. Slope is a more important factor in erosion than either vegetation or soil type. 

1. Click in the %Inf field next to the Slope Grid theme. Type "50". Fifty percent of the erosion hazard value for the output theme will be determined by the slope. 

2. Scroll down to the Soilsgrid theme. Click in the %Inf field and type "25". 

3. Scroll down to the Vegetation Grid theme. Click in the %Inf field and type "25". 
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The Sum of influences field at the bottom of the panel now equals 100 percent. 

Task 14: Assign evaluation scale values to the input theme values
In the weighted overlay table, the Scale Value field is used to assign an erosion potential (from 1 to 9) to each slope, soil, or vegetation type. Low scale values indicate low erosion potential; high values indicate high erosion potential. A special value, "Restricted", is used for areas where no data is available or there is a body of water. These areas will not be included in the erosion hazard assessment. 

1. For the Slope Grid theme, the erosion potential increases as the slope increases. Click in each cell of the Scale Value field and type the numbers shown in the following graphic. Type "r" for the Restricted value. (You can also click values from the dropdown list that appears when you click in a cell.) 
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2. For the Soilsgrid theme, set the scale values as shown in the following graphic. 
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As before, a value of 1 indicates low erosion potential; a value of 9 indicates high erosion potential. Bedrock has very low potential, and clay loam has very high potential. The other soil types are moderately prone to erosion. 

3. For the Vegetation Grid theme, set the scale values as shown in the following graphic. 
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Nonforested areas have very high erosion potential. Water bodies have no erosion potential, and forested areas have erosion potential based on the root depth of the major tree species. 

4. Click Next to continue. 

You have specified each theme's overall influence and ranked each slope, soil, and vegetation category on its contribution to the erosion hazard. You are now ready to overlay this information into a single erosion hazard theme.

Task 15: Define the properties of the Erosion Hazard output theme

Currently, the Restricted color is light red. You will change it to blue to represent water bodies and areas of no data. 

1. On the color scheme panel, double-click on the Restricted color in the Color field. The Color dialog box opens. 

2. In the Basic colors palette, click a bright blue color and click OK. 
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The color of the Restricted class changes to blue. 
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3. Click Next to continue. 

4. On the extent panel, the extent of the output theme is set to Studyarea.shp. This is the extent you want to use. Click Next. 

5. On the cell size panel, the cell size of the output theme is set to 30 meters. Click Next to accept this size. 

6. On the documentation panel, the Comments tab is selected. In the text box, type "This process determines the erosion hazard by combining soil, slope, and vegetation data". Click Next. 

7. On the output theme panel, click in the theme name text box and type "Erosion Hazard". Click in the file name text box and type "hazard". 

8. Click Finish to add the process to the model. Click the Full View [image: image63]button. The input themes have been connected automatically to the Weighted Overlay Process. 
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You now have a complete erosion hazard model. It converts an elevation DEM file to an elevation grid theme, then the elevation theme to a slope theme. It converts the vegetation theme (based on a shapefile) to a vegetation grid theme. It ranks slope, soil type, and vegetation type on an evaluation scale of erosion hazard. Finally, it weights and combines the slope, soils, and vegetation scale values to create an overall erosion hazard value on a uniform scale of 1 to 9. The overall erosion hazard values will become the values of the cells in the output theme. 

Task 16: Save and run the model
1. Click Save. 

When you run a model, you can run the entire model or particular processes within it. By right-clicking a function node and choosing Run, you run only the process to which the node belongs and any processes on which that process is dependent. 

2. Right-click the Slope function node and click Run. 
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After the process runs, the Slope Grid theme and the Elevation Grid theme are created in the view. 
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Because the Slope Process is dependent on the DEM Conversion Process, both processes run. These processes are now marked with drop shadows in the model window. 
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3. Click Run to run the entire model. 

The Elevation Grid, Vegetation Grid, Slope Grid, and Erosion Hazard themes are created in the view. 
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In the model window, all nodes have drop shadows, indicating that the model has been run.

Task 17: Analyze your results and modify the model

After looking at the Erosion Hazard theme created by the model, you might decide to change some of the erosion potential values. Because all the properties you set are saved in the model, you can adjust the properties and rerun the model to get new results. 

1. Right-click the Weighted Overlay function node and click Properties to open the Weighted Overlay property sheet. 

2. Make sure the Overlay Table tab is selected. Scroll down to the Soilsgrid theme. Click the Scale Value cell for Clay loam and change its value from 9 to 3. Click OK. 
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3. Click the Run button. 

A new version of the Erosion Hazard theme overwrites the old one. It has more light red areas, indicating lower overall erosion hazard than the previous version. 
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Task 18: Exit ModelBuilder and close the ArcView GIS project
1. In ModelBuilder, click the File menu and click Exit. Click Yes when you are prompted to save changes to the current model document. 

2. In ArcView GIS, click the File menu and click Close All. Click the File menu again and click Close Project. Click Yes when you are prompted to save changes to the project. 

2.2 Exercise 2: Housing Suitability modeling

Soon you will be moving to a new community to start a new job. You would like to create a map of potential home sites that are within your price range, close to schools, and have a low crime rate. 

ModelBuilder will help you create a simple housing suitability model in a few steps. You'll create distance buffer zones around schools and reclassify property values into those falling within and outside your price range. Then you'll perform a weighted overlay that combines the school buffer zones, reclassified property values, zoning, and crime frequency data. The result will be a map showing the suitability of each residential area. 

In this exercise you will learn: 

· How to set the model default properties 

· How to create processes and define their properties using the wizards 

· How to create processes using drag-and-drop tools, then define their properties using property sheets 

· How to edit process properties to perform "what if" analyses. 

Task 1: Start ArcView GIS and load the project

1. Start ArcView GIS if it is not already started. 

2. If your screen displays the Welcome to ArcView GIS dialog box, click to open an existing project and click OK. Otherwise, close any open projects, click the File menu, and click Open Project. 

3. Navigate to the av_gis30\avtutor\spatial\model\exercise2 folder. Double-click exercise2.apr. 
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When the project opens, the ModelBuilder and Spatial Analyst extensions are already loaded. The view contains five themes: Schools, Streets, Residential Zones, Property Values, and Crime. 
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The Schools theme will be used to create favorable buffer zones around schools. The Property Values theme will be reclassified based on your price range for homes. The Crime and Residential Zones themes will be overlaid with the school buffers and the reclassified property values to determine an area's suitability. The Streets theme is used to display the streets adjacent to the suitable areas and is not used by the model. 

Task 2: Start ModelBuilder and set the model defaults

You will create the housing suitability model in the ModelBuilder window. Here, you will define how input data will be processed to create output data. 

1. In ArcView GIS click the Model menu and click Start ModelBuilder. 

First, you will set the model default properties. These settings automatically appear in the wizards when you create processes. Setting defaults saves you the work of reentering the same values each time you add a process. 

You will set the default extent for the output themes to the extent of the Residential Zones theme. You are only interested in the city's residential areas, even though some of the input themes extend beyond this area. 

2. In ModelBuilder, click the Model menu and click Model Defaults. Make sure the Extent tab is active. Click the option to set the extent of the output theme to the extent of this theme. Click the dropdown arrow and click Residential Zones. 
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You will set the default cell size to provide the best resolution for the output themes without making the output files too large. 

3. Click the Cell Size tab. Click the option to set the cell size to the cell size of this theme. Click the dropdown arrow and click Property Values. The cell size of this theme is 50 feet. Click OK. 
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Task 3: Create a Buffer Process for the Schools theme

You will create buffer zones around schools to find residential areas that are close enough to schools to be convienient, but not so close as to be subject to excessive noise. To create buffer zones, you will define a Buffer Process using the Buffer Wizard. 

1. Click the Add Process menu and click Buffer. Read the introductory panel and click Next. 

2. On the input theme panel, click the dropdown arrow and click Schools. Click Next. 

3. On the buffer settings panel, type "4" as the number of buffers. Type "0.25" as the default buffer width. Click the buffer units dropdown arrow and click Miles. Click Next. 
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The buffer table displays four buffer zones, each one-quarter of a mile in width. You will make buffers of different widths. 

4. Click the End Distance field of the third buffer record. Type "1" in place of the existing value and press Enter. 
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Note that the Start Distance value of the next record is automatically updated. 

5. Click on the End Distance field of the last buffer record. Type "2" in place of the existing value and press Enter. Two miles from a school is the maximum acceptable distance. Click Next. 
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6. On the color scheme panel, click the Orange Monochromatic color ramp. The output theme will use these colors. Click Next. 
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7. On the extent panel, the output theme extent is set to Residential Zones, as you specified in Task 2. Click Next. 

8. On the cell size panel, the cell size is set to that of the Property Values theme(50 feet), as you specified in Task 2. Click Next. 

9. On the documentation panel, the Comments tab is selected. In the text box, type "Housing within 2 miles of schools is suitable".; Click Next. 

10. On the output theme panel, click in the theme name text box and type "School Buffers". Click in the file name text box and type "schoolbuf". Click Finish. 
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Task 4: Create a data node for the Property Values theme

The Property Values theme displays the value of each residentially zoned property. You will reclassify the property values into ranges that you can afford and those outside your price range. To do this, you will create a Reclassification Process using the drag-and-drop tools. You will then define the process properties with property sheets. 

First, you will create the data node that represents the Property Values theme. 

1. Click the Add Data button and click anywhere in the model window. An undefined data node with the name "Data" appears in the model. 
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2. Right-click the Data node and click Theme. 
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The project data node changes to a theme node. This tells ModelBuilder that the process you are building will use a theme from the ArcView GIS project, rather than a DEM file on disk. 

3. Right-click the Theme node and click Properties. 

4. On the input data property sheet, type "Property Values" as the project data name. 

5. Click the input theme dropdown arrow and click Property Values. Leave the input field set to Value. Click OK. 
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In the model window, the data node is called Property Values. It turns blue to indicate that its properties have been defined. 
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Task 5: Create function and derived data nodes for the Reclassification Process
1. Click the Add Function [image: image84.png]


 button and click in the model window. An undefined function node and a connected derived data node appear in the model. 
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2. Right-click the function node and click Reclassification. The name of the node changes to Reclass. 
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3. Click the Add Connection [image: image87.png]


 button and drag a line between the Property Values and Reclass nodes. 

4. Click the Auto Layout [image: image88.png]


 button. If necessary, click the Full View [image: image89.png]


 button. 

The Reclassification Process is now ready to run, but you will edit some of the default property settings. 
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5. Right-click the Reclass node and click Properties. 

The Reclass function property sheet displays the default classification table. You will change the classes to $100,000 price ranges. First, you'll set the minimum and maximum of the price ranges. Then you'll define the number of ranges between the minimum and maximum. 

6. Click the Class Start Value field of the first record. Replace the existing value with "0" and press Enter. Click the Class End Value field of the last record. Replace the value with "500000" and press Enter. 
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7. Click Classify. Make sure the classification method is set to Equal Interval and the number of classes is set to 5. Click OK. 
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8. Click OK on the updated panel. 
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9. Right-click the Reclass Map node and click Properties. 

10. On the property sheet, the Output Theme tab is selected. In the theme name text box, type "Res Prop Values". Click OK. 
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Task 6: Add a Weighted Overlay Process to the model

By adding a Weighted Overlay Process to your model, you can combine the school buffers, residential zones, property values, and crime data to find the most suitable housing. 

You added the Buffer Process with a wizard. You created the Reclassification Process with drag-and-drop tools and property sheets. For the Weighted Overlay Process, you will combine these methods, using drag-and-drop tools to create the function node and the wizard to define the input themes and properties. 

1. Click the Add Function button [image: image96.png]


 and click in the model window. It's all right to place the new node on top of existing processes. 
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2. Right-click the function node, point to Overlay, and click Weighted Overlay. The name of the node changes. 
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3. Right-click the Weighted Overlay function node and click Wizard. 

4. Read the introductory panel and click Next

Task 7: Set the common evaluation scale for the Weighted Overlay Process
The Weighted Overlay Process combines your input themes to find the most suitable housing sites. To overlay themes that are not alike, such as Property Values and Crime, you have to convert the values in each theme to a common evaluation scale. The scale you will use represents suitability, with 1 being least suitable and 5 being most suitable. 

1. On the evaluation scale panel, click the predefined evaluation scale dropdown arrow and click 1 To 5. 
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2. Click Next to continue. 

Task 8: Add the themes to be overlaid
The weighted overlay table is where you define the input themes, weights, and scale values. 

1. On the weighted overlay table panel, click Add Theme to open the Theme and Field dialog box. Click the input theme dropdown arrow and click Residential Zones. Click the input field dropdown arrow and click Label. Click OK. 
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2. On the weighted overlay panel, click Add Theme again. Click the input theme dropdown arrow and click Crime. Click the input field dropdown arrow and click Label. Click OK. 
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3. Click Add Theme again. Click the input theme dropdown arrow and click Res Prop Values. The input field dropdown list is set to Value (the only choice). Click OK. 

4. Click Add Theme. Click the input theme dropdown arrow and click School Buffers. The input field dropdown list is set to Value (the only choice). Click OK. 

All four input themes have been added to the weighted overlay table. You will now set the influence factor for each theme. 

Task 9: Set the influence factor for each theme

What is important to you when you look for a new home? Price, of course, but probably other factors, such as a low-crime neighborhood. The Weighted Overlay Process allows you to set weights for as many different factors as you want to analyze. The weight establishes the relative importance of the factor under consideration. The sum of the weights must equal 100 percent. 

1. Click in the %Inf field next to the Residential Zones theme. Type "30". Thirty percent of the overall housing suitability will be determined by the values in the Residential Zones theme. 

2. Click in the %Inf field next to the Crime theme. Type "30". Crime rates will also have an influence of thirty percent on the output theme. 

3. Scroll down to the Res Prop Values theme. Click in the %Inf field and type "30" to give residential property values an influence of 30 percent. 

4. Scroll down to the School Buffers theme. Click in the %Inf field and type "10". Proximity to schools will have a ten percent influence on housing suitability. 
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The Sum of influences box at the bottom of the panel equals 100 percent.

Task 10: Assign evaluation scale values to the input theme values

The Scale Value column allows you to assign a common evaluation scale value to each category in each theme. Because you chose an evaluation scale of 1 to 5, you can use any of these numbers in the Scale Value column. You can also set a value to Restricted. Areas that are restricted, such as completely unsuitable areas or areas where there is no data, are excluded from the analysis. 

In this analysis, you will assign the value 5 to the most suitable areas and 1 to the least suitable. 

1. Click in each Scale Value cell for the Residential Zones theme and type the numbers shown in the following graphic. Type "r" for the Restricted value. You can also click values from the dropdown list that appears when you click in a cell. 
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The values you entered indicate that you want to live in a residential area, but would strongly prefer not to live in a planned community. You will not consider a mobile home or any area not zoned for residential use. 

2. For the Crime theme, set the scale values as shown in the following graphic. 
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You want to live in a low-crime area. You will consider areas where crime is above average, but not where it is high. 

3. For the Res Prop Values theme, set the scale values as shown in the following graphic. 
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Properties in the $100,000 to $200,000 range are affordable. Less expensive properties will need repairs and are therefore slightly less suitable. More expensive properties are hard to afford. Houses above $300,000 are too expensive to consider. 

4. For the School Buffers theme, set the scale values as shown in the following graphic. 
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You want to live near a school, but not too near. You give the highest suitability value to properties that are one-quarter to one-half mile from schools. Properties more than two miles from a school have not been buffered and will automatically be excluded from the analysis. 

5. Click Next to continue.

Task 11: Define the properties of the Housing Suitability output theme

1. On the color scheme panel, click the Yellow Monochromatic color ramp. 
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2. Double-click the Restricted color in the Color field. The Color dialog box opens. 
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3. In the Basic colors palette, click the white square and click OK. 

4. Double-click the color for value 5 in the Color field. 

5. In the Basic colors palette of the Color dialog box, click the red square and click OK. 

[image: image109.png]e

Beko i the oo schem forth ot theme.To change l e
Red Monachonaic cr, e on ok e e sl st el o change
il ok e Sk e 1 ko colan,

:
| :
ellow Monochromatic. X

:

:

Chatieus Honechumai

Green Morachamatc

o @

= Cheall||| e e | |





Areas that are out of consideration will be displayed in white. Red areas can be quickly identified as the most suitable. 

6. Click Next to continue. 

7. On the extent panel, the extent of the output theme is set to Residential Zones, as you specified in Task 2. Click Next. 

8. On the cell size panel, the cell size is set to the size of the Property Values theme, also specified in Task 2. Click Next. 

9. On the documentation panel, the Comments tab is selected. In the text box, type "This process weights residential zones, crime, property values, and proximity to schools to locate suitable housing." Click Next. 

10. On the output theme panel, click the theme name text box and type "Preferred Res Areas". Leave the default file name as it is. Click Finish. 

11. Click the Full View [image: image110.png]


 button. 

The complete model displays in the ModelBuilder window. 
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Task 12: Save and run the model

1. In ModelBuilder, click the File menu and click Save. Navigate to the folder where you want to save the model (for example, c:\temp). In the Model name text box, type "Exercise2". Click OK. 

2. Click the Run [image: image112.png]


 button. The School Buffers, Res Prop Values, and Preferred Res Areas themes are created in ArcView GIS. 

3. In the ArcView GIS Table of Contents, click the Streets theme and drag it to the top of the Table of Contents. 
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Based on these influence weightings and scale values, there is a highly suitable neighborhood in the southwest part of the study area, as well as scattered smaller areas to the north and northwest. ModelBuilder makes it easy to do "what if" analyses by letting you change the percentage influences, the evaluation scale values, or both.

Task 13: Modify the model

1. Click the ModelBuilder window to make it active. Right-click the Weighted Overlay function node and click Properties. 
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2. The Overlay Table tab is selected. Make some changes to the influence weights and scale values. You can make the changes shown in the next graphic or experiment on your own. In the graphic below, the property sheet has been resized by dragging the right corner so that the entire weighted overlay table will display. 
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3. On the property sheet, click Run and click OK. 

The output theme is recalculated. 

4. In the ArcView GIS Table of Contents, click the Streets theme and drag it to the top of the Table of Contents. 
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With the new weightings and scale values, there are more highly suitable areas, located in the northeast and southwest sections of the study area. 

Part 3: Working with ModelBuilder
To work with models, you use the ModelBuilder interface to build, revise, import and export models. To learn details about how to work with models, see the links below. 

The ModelBuilder interface 

The ModelBuilder interface is a window where you build the model and a set of tools to help you build it. The model window displays the model graphically as a set of nodes that represent processes and connector lines showing the flow of processing. Above the model window is a menu bar and a toolbar that give you access to the tools needed to build, edit, view, and run a model. 

Setting up data for ModelBuilder 

Each process in a model requires a specific kind of data, such as a vector theme, grid theme, or DEM (Digital Elevation Model) file. The data does not have to be available to build the model, but it must be present when you run the model. Vector and grid themes must be in the current ArcView project, and DEM files must be available in the specified path before the model will run. You can check the model status in the Model menu to determine if a model has all the data it needs to run. 

Setting up model defaults and documentation 

Before you begin building a model, you might want to set up the model properties and model defaults. Model properties include the model name and any documentation of the model. Model defaults are a set of default properties, such as the color scheme, extent, and cell size of the output theme. 

Building a model 

You build a model by adding, connecting, and editing processes. You can add processes using wizards that walks you through adding the process and defining its properties, or you can use drag-and-drop tools to add the process, then define the properties using property sheets. 

Navigating the model window 

When you are building or viewing a model, you may want to change the part of the model displayed the model window by zooming or using the Overview window to select the part of a model to be displayed. 

Saving a model 

When you save a model, it is saved in working folder created on your disk drive. When the model is run, the data created by the model is also saved in the working folder. You can save a model under a new name, which creates a new working folder with a renamed copy of the model. 

Running a model 

You can run an individual process within a model, run only those processes that have not been run, or run the entire model. When you run a process or model, derived data is created in your working folder. 

Revising a model 

You can change the properties of processes in a model using wizards and property sheets. You can also delete, add, connect, and disconnect processes and data in the model. 

Printing a model 

You can set up the printouts of the model to have page numbers, a border, a caption, and crop marks. Every time you save a model, a graphic (.bmp) file of the model is saved. You can print the graphic file or use it in an ArcView layout. 

Importing a model 

You can import existing models and link them into the current model you are building. 

Exporting a model 

You can make a copy of part of your model without copying the entire model. You select the part to be copied, and export it into its own model file. You can also export all of a model, which is the same as saving it as a new file. 

Sharing a model 

After building and saving a model, you can share the model with others by giving them just the model, or the model and the data. Others could edit your model to use their input data, and they could edit the processes in your model to fit their purpose. 

Adding text to a model 

You can add text to a model and place it anywhere in the model. 

Changing the model layout and symbols 

By default, you build models left-to-right, but you can build them right-to-left, top-to-bottom, or bottom-to-top. You can choose the spacing and alignment of nodes in the model, and you can change the colors of text and nodes.

	3.1 The ModelBuilder interface


The ModelBuilder interface consists of menus, a toolbar, and the model window. 
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The menus 

The ModelBuilder menus are pulldown menus found in the menu bar of the ModelBuilder interface. To view the details for a menu, click on the links below: 

The File menu - Create, open, close, import, export and save models. 

The Edit menu - Cut, copy, paste, delete and select nodes in your model. 

The View menu - Zoom the model using predefined or custom zoom values, set up an overview window, and change the layout of the model. 

The Model menu - Set model defaults, document the model, check its status, and run the model. 

The Add Process menu - Add processes to your model using wizards to guide you. 

The Help menu - Open the ModelBuilder help window. 

The toolbar 

The ModelBuilder toolbar - Quick access to the most commonly used features. Open, save, and run models, edit processes, zoom the view, and drag-and-drop nodes. 

The model window 

The model window - build and view your model in the model window. 

The File menu
The File menu has choices that manage the model files, such as creating, opening, saving, printing, importing, and exporting a model. 

Some menu choices have shortcut keys so you can access them without pulling down the menu. For example, the Open choice displays "Ctrl+O" next to it, so you can hold down the Ctrl key and press the O key to open a new model. 

Click on a menu choice in the graphic below to jump to the help for that menu choice. After reading about the menu choice, you can click the up arrow to return to this location. 
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New 

Choose New to create a new model. If you have another model open and it has not been saved, you will be prompted to save the current model before the new model is created. 
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Open 

Choose Open to open an existing model. The Open window prompts you for the location of the model file on the disk. Navigate to the proper folder and highlight the model you wish to open, then click the Open button. Model files have a ".xmd" extension. 
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Close 

Close the model. If the model has not been saved, you are asked if you want to save it. Click the Yes button to save and close the model; click the No button to close the model without saving. The ModelBuilder window remains open. 

Save 

Save the model. The model remains open and editable. If the model has never been saved, a Save As window (shown below) will open, prompting you for the name of the model and the folder to save it in. 

Save as 

Save the model under a new name. The model remains open and editable, and the name changes to the new name. Any changes you make to the model will be saved under the new name. If you saved the model previously under another name, that model remains on the disk drive but is no longer the active model. This option is useful if you have a model saved under one name and you want to save it under another name to make a copy of it. 
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Import Model 

Import a model into the open model. A popup window appears prompting you to choose a file containing the model to be imported. The imported model will be added to the current model. 
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Export Model 

The Export Model choice will save all or part of a model to a file. This file can be imported into another model. Export works the same as Save As, except it does not save the entire model if portions of it have been selected. If a process is selected, it will be saved, as well as any other processes it depends on, regardless of whether they are selected or not. 
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Print 
Print the contents of the model window. The options on the Print popup window, such as the properties and names of available printers, will depend on the printer drivers installed on your machine. Choose a printer from the dropdown list. Press the OK button to begin printing to the printer. If you check the Print to File box, you will be prompted for a file name with a .prn extension. When you click OK, the print job will be stored in a file for printing later. 
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Print Setup 

The Print Setup choice lets you set options for printing to a printer and to a file. The Print Setup window does not actually print the model. After you change the setup, you must choose Print from the File menu to print the model. 

If you choose the Scale By Pages selection on the To Printer tab, the model is scaled so that when it is printed, it will print across the number of pages across (Page Columns) and down (Page Rows) you specify. The Actual Size selection will scale printouts to actual size size of the model, regardless of the number of Page Rows and Columns set. The Margins textbox allows you to set the width of the margins on all sides. The check boxes allow you to choose whether page numbers, the model caption, a border, and crop marks will appear on your printout. (You can set the caption by selecting Model Documentation from the Model menu and clicking the Caption tab). 

Each time you save a model, a graphic (.bmp) file is saved in the model folder. On the To File tab, you can scale the size of the graphic file. See Print Setup or click the Help button on the Print Setup window to learn more about these options. To restore the default settings, click the Default button. 
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Most Recent Model Files 

Select from the last four models that were opened. This is a quick way to open a model you worked with recently. 

Exit 

Close the model and the ModelBuilder window. If the model has changes that have not been saved, you are prompted to save the changes before exiting. 

The Edit menu

The Edit menu contains options to modify the processes in a model. You can cut, copy, paste, and delete a node within a process, or select all nodes in the model. You can also delete a connection drawn between two nodes. 

Click on a menu choice in the graphic below to jump to the help for that menu choice. After reading about the menu choice, you can click the up arrow to return to this location. 
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Cut 
Cut deletes the selected nodes from the model, and saves them so that they can be pasted. Selected nodes appear with a dashed rectangle around them. 

Copy 

Copy the selected nodes. Another node of the same type and with the same parameters will be added to the model when you paste the copied nodes. 

Paste 

Paste the cut or copied nodes into the model. 

Delete 

Delete the selected nodes from the model. If no node is selected, nothing will be deleted. If one or more nodes are selected, a popup window (shown below) prompts you to confirm the deletion. 
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Select All 

Select every node and connector line in the model. Selection handles (small squares) and a dashed rectangle appear around every node. Selected connector lines appear in red. You can move, delete, cut, copy, and paste the selected nodes and connector lines. 
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The View menu

The view menu allows you to change the way you look at a model in the ModelBuilder. You can change the layout of the processes in the model and zoom in or out to view as much of the model as you want. You can also open a small overview window where you can use the mouse to pan around the model in the larger ModelBuilder window. 

Click on a menu choice in the graphic below to jump to the help for that menu choice. After reading about the menu choice, you can click the up arrow to return to this location. 
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Auto Layout 

The Auto Layout choice moves the nodes in the model around to create a more appealing layout. It moves project data nodes to the left and derived data nodes to the right and balances them in the document window. The graphic below shows a model before and after using the Auto Layout menu choice. 
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Full View 

The Full View choice zooms the view so that the entire model fits in the current window size. The graphic below shows a model before and after selecting Full View. 
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Zoom In 

This menu choice zooms in by 25% so that you can see a smaller area of the model. This lets you see more detail. 

Zoom Out 

This menu choice zooms out by 25% so that you can see more of the model. 




25%, 50%, Actual Size, 200%, 400% 

This menu choice resizes the model by the specified amount so that you can see more or less of it. 

Custom Zoom 

Set a custom zoom level by typing a percent in the text box. 

[image: image133.png]Eterthe custom zoom level





Layout Properties 

The Layout Properties menu choice opens a popup window with settings that affect the look of the model. The General Option tab allows you to choose automatic or manual layout modes. Manual layout can be set to snap the nodes in the model window to a grid (Nodes are the graphic representations of data and functions in the model). The Layout Options tab has choices that affect the placement and spacing of nodes, whether the connector lines are diagonal or orthogonal, and whether they point to the edge or center of the node. See Setting layout properties or click the Help button in Layout Properties for details about each setting. 
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Layout Symbols 

The Layout Symbols choice lets you set the color, size, and shadowing of each node. Nodes are the graphic representations of data and functions in the model. For project data, function data, and derived data nodes, you can set a different look for each state of the node (not ready to run, ready to run, or has been run). For more details, see Layout Symbols. 
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Overview Window 

This menu choice opens a small overview window showing a small version of the entire model. You can change the view in the larger ModelBuilder window by drawing a selection area in the overview window and dragging the selection area around the overview window. The selection area in the overview window fills in the model window. 
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The Model menu

The Model menu has choices that apply to the entire model, such as documenting the model, checking the model status and running part or all of the model. There is an option setting model defaults for wizards and property sheets, such as the default legend colors, cell size, and extent of the output theme. 

Click on a menu choice in the graphic below to jump to the help for that menu choice. After reading about the menu choice, you can click the up arrow to return to this location. 
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Model Defaults 

Choose Model Defaults to set the default parameters that will appear in the wizard panels and property sheets. Default parameters you can set on the include the extent and cell size of the output theme, the default legend settings, and the default evaluation scale for Weighted Overlay Processes. 

For more information about model defaults, see Setting up model defaults and documentation. 
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Model Documentation 

Choose Model Documentation to create a model caption and document any comments, assumptions, citations, and web sites that you used when building the model. On the Caption tab, set the model caption. It appears as the title of the overview window and in printouts if you select Print Setup from the File menu and check Print Model Caption. To learn more about documenting a model, see Setting up model defaults and documentation. 
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Check Model Status 

Choose Check Model Status to test the model to see if all input data is available and the model is ready to run. The symbols of the nodes in a model will change to reflect their status of not ready to run, ready to run, or already run. See Layout Symbols to learn how to change the symbols for nodes. 

Run Model 

Run all processes in the current model that have not been run or that have been edited since the last run. Processes that have been run and have not changed will not run again. To verify which processes have been run, choose Check Model Status from the Model menu. For more information, see Running a model. 

Run Entire Model 

Run all processes in the current model, regardless of whether they have already been run. For more information, see Running a model.

The Add Process menu

The Add Process menu allows you to build a model by adding processes to it. When you select a process, the wizard for that process opens and walks you through defining the process and adding it to the model. To see a list of available wizards, see Model Processes. 
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The Help menu

The Help menu allows you to access the ModelBuilder Help (the window you are now reading) and to view the splash screen that appears when the ModelBuilder is started. You can also view version and copyright information. 

Click on a menu choice in the graphic below to jump to the help for that menu choice. After reading about the menu choice, you can click the up arrow to return to this location. 
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ModelBuilder Help 

The ModelBuilder Help choice opens the ModelBuilder Help window. You can navigate the help system by clicking on a topic in the Contents tab, typing in a topic in the Index tab, searching for a word or phrase in the Search tab, or by bookmarking frequently used pages in the Favorites tab, then double-clicking on them to go to the bookmarked page. On any wizard or property sheet, you can click the Help button to go to a specific page in the Help. 
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ModelBuilder Splash Screen 

The ModelBuilder splash screen displays briefly when you start ModelBuilder. The ModelBuilder Splash Screen menu choice displays the splash screen until you dismiss it. You can get version and copyright information from the splash screen. 
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About ModelBuilder 

The About ModelBuilder choice displays a window showing the ModelBuilder version number and copyrights.
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The ModelBuilder toolbar

The ModelBuilder toolbar contains the most commonly used options. The names of the tools on the toolbar are shown below. Click on a tool in the graphic below to jump to the help for that tool. After reading about the tool, you can click the up arrow to return to this location. 
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[image: image146.png]


 New - Create a new model. If you have another model open and it has not been saved, you are prompted to save the current model before the new model is created. 
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 Open - Open an existing model. Navigate to the proper folder and highlight the model you wish to open, then click the Open button. 
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[image: image149.png]


 Save - Save the model to the disk drive. The model remains open and editable. If the model has never been saved, the Save As window (shown below) prompts you for the name of the model and the folder to save it in. 
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 Print - Print the model. A popup window, shown below, prompts you to select the printer. Choose a printer and press the OK button. 
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 Cut - Delete the selected objects from the model, and save them so that they can be pasted. 
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 Copy - Copy the selected objects. Another object of the same type and with the same parameters will be added to the model when you paste the copied objects. 
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 Paste - Paste the cut or copied objects into the model. 
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 Auto Layout - Move the nodes in the model so that they are more evenly balanced across the model. The graphic below shows a model before and after using the Auto Layout tool. 
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[image: image159.png]


 Full View - Zoom the view so that the entire model fits in the current window size. The graphic below shows a model before and after using the Full View tool. 
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[image: image161.png]


 Zoom In - Zoom the view of the model in by 25% so that you can see a smaller area of the model. 
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 Zoom Out - Zoom the view of the model out by 25% so that you can see more of the model. 

[image: image163.png]


 Zoom - Drag a rectangle around the area you want to see more closely. The view will zoom in on that area. 
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 Select - Select a node in the model. Click this tool, then click on a node. Its outline changes to a dashed line and it has small rectangles, called handles, in each corner that can be used to drag it to a new location. Function nodes and derived data nodes are always selected in pairs because they are always added or deleted together. In the graphic below, the select tool was clicked on the function node. Both the function and derived data nodes were selected as a pair. 
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 Add Data - Add a project data node to the model. Click this tool, then click inside the model. (You must connect this project data node to a function node using the Add Connection tool.) To learn more about project data, see What is a process?. 
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 Add Connection - Draw a connecting line between data and a function to define which input data will be associated with a process. 
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 Add Function - Add a function node and derived data node to the model. Click on this tool, and click in the model. A function node and an attached derived data node are added to the model. (You must connect the function to project data using the Add Connection tool so that there is some input data for the process.) To learn more about working with data and function nodes, see What is a process?. 
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 Add Bend - Add a bend to a connector line by clicking the Add Bend tool, then clicking on the connector line. You can drag the bend to a new location to change the shape of the line. You can add as many bends as you wish. In the graphic below, a bend was added to the highlighted connector line. 
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  Delete Bend - Delete a bend in a connector line by clicking on it with the Delete Bend tool. 

[image: image172.png]


  Add Text - Add a text node to the model. To edit the text and define its color, double-click it to open its properties window. 
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 Run Model - Run the current model. Any processes that have not been run will be run at this time. The results will be added as a theme in ArcView. 

	The model window


The model window is your work area where your model displays. The window contains the nodes that represent processes and the connector lines that show the flow of processing in the model. 

To make any changes to the model window, you use the menus, the toolbar, or you right-click in the model window. You can add nodes to the model window from the Add Process menu or using the drag-and-drop tools on the toolbar. From the View menu, you can zoom in and out, and rearrange the layout of the nodes in the model window. You can also open a small overview window that allows you to pan and zoom around the model window to view various parts of the model. 

When you right-click inside the model window, a menu displays. The choices on the menu depend on whether you click on a node, a connector line, or white space. If you right-click on a node, the menu gives you choices that relate to that type of node. For example, if you click a function node, you get choices to open the property sheet or wizard, run the process, or delete the node. If you right-click on a connector line, you can delete it. If you right-click on white space in the model window, you get common editing tools such as cut, copy, paste, delete, and select all nodes. 
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3.2 Setting up data for ModelBuilder

ModelBuilder accepts several types of data as input, including DEM files, grid themes, and vector themes (points, lines, and polygons). Vector themes may be in the form of ArcView shapefiles, ArcInfo coverages and CAD drawings imported into ArcView. The type of input accepted depends on the process you are building. See Data Requirements for a list of the data types accepted by each process. For more details about data formats, see the glossary terms Grid theme and DEM file. 

Before you add themes in ArcView to be used as input data for a model, you should set the map units in the view. The map units should be the same as the units of the data you will add. See Setting map units for details. Many of the ModelBuilder processes use the map units when creating derived data. 

Before you can add a process using a wizard, the input data must be available to the model. To make data available, you add it as a theme in the current ArcView project. The exception to this is DEM (Digital Elevation Model) data, which is not added in ArcView, but must be available on a disk drive. 

In a model, project data nodes represent the input data. By default, if a project data node is white, it means that the input data has not been selected or is not available. All nodes in the process are white because the process cannot run (You can change the colors used to indicate node status; see Layout Symbols and Determining process status). 
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When the project data node is fully defined and can find the input data, it changes color, as shown in the graphic below. 
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Data requirements

Each process has its own data requirements. The table at the bottom of this page lists the processes and the data types required by each process. If the acceptable input data type is a theme, the theme must be in the current ArcView project so the model can find it. If the acceptable data type is a DEM file, the location of the DEM file on your disk drive must be specified in the process properties. To learn more about each process, click on its name in the table. 

ModelBuilder will not let you use an inappropriate data type in a process. When using a wizard, the wizard will only let you choose input themes or files that are of the appropriate data type. When creating a process using the drag-and-drop tools, you can connect a data node to a function node only if the data type is correct for that function. The choices of fields within a theme will also be restricted to the appropriate data types. 

	Process 
	Acceptable input data type 
	Acceptable input field type 

	Vector Conversion 
	Point, line, or polygon themes (including ArcView shapefiles, ArcInfo coverages, and CAD themes) 
	Integer numbers, 
Floating point numbers, 
Character strings, 
Dates 

	DEM Conversion 
	DEM file 
	Not required 

	Point Interpolation 
	Point or PointZ theme 
	Integer numbers, 
Floating point numbers 

	Slope 
	Discrete or continuous grid theme 
	Not required 

	Aspect 
	Discrete or continuous grid theme 
	Not required 

	Hillshade 
	Discrete or continuous grid theme 
	Not required 

	Contour 
	Discrete or continuous grid theme 
	Not required 

	Reclassification 
	Discrete or continuous grid theme 
	Integer numbers, 
Floating point numbers, 
Character strings, 
Dates 

	Buffer 
	Discrete grid theme 
	Not required 

	Arithmetic Overlay 
	Discrete or continuous grid theme 
	Integer numbers, 
Floating point numbers, 
Character strings,
Dates 

	Weighted Overlay 
	Discrete grid theme 
	Integer numbers, 
Character strings,
Dates 


3.3 Setting up model defaults and documentation

Before you begin building a model, you might want to document the model and set the model defaults. You can document a model and set its print caption by selecting Model Documentation from the Model menu in the ModelBuilder window. If your model is well documented, it will be easier to understand later. See the following topic for more details: 

Model Documentation 

You can set model defaults such as the legend color, extent, cell size, and evaluation scale, by selecting Model Defaults from the Model menu in the ModelBuilder window. These settings appear as the default choices in wizards and property sheets that use the properties. 

If your model will have several processes that create output themes, default settings help to ensure that the output themes will have the same properties. For example, you will most likely want all your output themes to have the same extent and cell size so that they overlay exactly and have the same resolution. If you set the default extent and cell size before you begin building the model, you can accept the default properties in wizards and property sheets knowing the output themes will align correctly. See the following topic for details: 

Model Defaults 

3.3.1 Model Documentation

a. Documentation tab 

You can document the model by entering comments, assumptions, citations, and URL sites on the Documentation tab. Documenting the model helps you and others to recall relevant information, such as why a particular method or process was chosen. The documentation is stored in the model. 

Comments, Assumptions, Citations 

Click on the Comments, Assumptions, or Citation tabs to write notes and references for this model in the text boxes. 

Reference URLs 

List links to Web sites that are pertinent to this model. These links are active. For example, if you enter www.esri.com and double-click on this link in the property sheet, you will open a browser and go directly to the ESRI Web site. 

b. Caption tab 

You can enter a print caption on this tab. The print caption is used in two places: it is the title of the overview window when you choose Overview Window from the View menu, and it appears at the bottom of printouts if you have Print Caption checked in Print Setup on the File menu. 

Print Caption 

Type in the caption for the model

3.3.2 Model Defaults

a. Extent tab 

The extent is a rectangle that defines the geographic area covered by the output theme. The extent also limits the area that will be processed by the model. North, south, east, and west coordinate values define the extent limits. When you set a default extent, that extent appears in wizards and property sheets as the default choice. This is convenient when you are creating several themes and you want them to have the same extent. 

You can set the extent to be the same as the union or intersection of input themes (see diagram below), specify the extent of another theme in your ArcView project, or enter a set of coordinates defining the extent limits. In some cases, you may want the output theme to cover a smaller area than the input theme. Reducing the geographic area of the output theme (sometimes referred to as clipping) reduces the amount of storage space and computation time required. For more details, see Extent. 

Setting the extent to the union of input themes creates an output extent large enough to include all input themes. Area not covered by an input theme will have a value of No Data. Setting the extent to the intersection of input themes will create an output extent that covers only the area that is represented by all input themes. 
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Set the extent of the output theme to the union of the input themes 

Choose this setting to make the extent of the output theme is large enough to encompass all input themes. The extent coordinates of this theme are shown in the lower portion of the property sheet. Choosing this setting ensures that all cells in the input theme will be processed to create the output theme. Cells that fall in areas not covered by input themes will have a value of No Data. 

Set the extent of the output theme to the intersection of the input themes 

Choose this setting to limit the extent of the output theme to an area that is covered by all input themes. The extent coordinates of this theme are shown in the lower portion of the property sheet. Choosing this setting ensures that every cell in the output theme is influenced by all the input themes. 

Set the extent of the output theme to the extent of this theme 

You can set the extent of the output theme to the extent of any other theme in your ArcView project. Click the down arrow to see a list of available themes and select a theme to use its extent for the output theme. The extent coordinates are shown in the lower portion of the property sheet. 

Set the extent of the output theme to these coordinates 

You can set the extent of the output theme by entering a set of four location coordinates defining the north, south, west, and east extent limits. These coordinates must be in the same map units as the view, (e.g., feet, meters). The coordinates you enter must fall inside the extent of the input theme to produce useful output. 

Apply to Entire Model 

If you want existing processes in your model to change to the default extent setting, click the Apply to Entire Model button, then click OK. If you want to leave existing extents alone and just set the default for new processes, just click OK. 

b. Cell Size tab 

You define a theme's resolution by setting its cell size. The default cell size will be presented as the default choice in wizards and property sheets. This is useful if you are creating several output themes and you want them all to have the same cell size. 

The cell size is measured in the same map units as the view. The smaller the cell size, the higher the resolution; the larger the cell size, the lower the resolution. The cost of reducing the cell size is to increase the amount of storage space and computation time required. Reducing the cell size cannot improve the accuracy of the data; the output theme you create can only be as accurate, not more accurate, than the largest cell size of all input themes. For more information, see Cell Size. 

Set the cell size of the output theme to the maximum cell size of the input themes 

The accuracy of the output theme cannot be greater than the accuracy of the least accurate input theme. By choosing the maximum cell size of all input themes, you preserve the accuracy in the output theme. The maximum cell size of the input themes is shown in the lower portion of the property sheet. The cell size is measured in map units, displayed to the right of the cell size. The number of rows, columns, and cells that will be in the output theme is also shown. The cell size and the extent determine the number of rows, columns and cells. For more information, see map units. 

Set the cell size of the output theme to the minimum cell size of the input themes 

Choosing the minimum cell size of the input themes may increase the resolution of the output theme, but it may also imply more accuracy than actually exists. The minimum cell size of the input themes is shown in the lower portion of the property sheet. The cell size is measured in map units, displayed to the right of the cell size. The number of rows, columns, and cells that will be in the output theme is also shown. The cell size and the extent determine the number of rows, columns and cells. 

Set the cell size of the output theme to the cell size of this theme 

You can set the cell size of the output theme to the cell size of any other theme in your ArcView project. Click the down arrow to see a list of themes. Click on a theme to select it. The cell size of the selected theme (in map units) is shown in the lower portion of the property sheet. The number of rows, columns, and cells that will be in the output theme is also shown. The cell size and the extent determine how many rows, columns and cells there will be. 

Set the cell size of the output theme to this cell size 

You can set the cell size of the output theme by entering a specific value. The value you enter must be in the same units (map units) as the view, (e.g., feet, meters). 

Apply to Entire Model 

If you want existing processes in your model to change to the default cell size setting, click the Apply to Entire Model button, then click OK. If you want to leave existing cell sizes alone and just set the default for new processes, just click OK. 

c. Range Legend tab 

When you group values into ranges, a color ramp is used to define the color scheme. You can define a default range legend color scheme will appear in those wizards and property sheets that use a range legend. 

Choose the default color scheme 

Click on any color ramp in the scrolling list at left to select it. That color ramp will become the default choice in wizards and property sheets. 

d. Distinct Legend tab 

When you classify unique values, each input value is assigned to its own output value with no grouping. A distinct legend is used to assign a distinct (not ramped) color to each output value. When you reclassify character data or integer data that represents categories, a distinct legend is used. 

Choose the default color scheme 

Click on any color scheme in the scrolling list at left to select it. That color scheme will become the default legend choice in processes that use a distinct legend. 

e. Evaluation Scale tab 

To weight the values in the input themes for the Weighted Overlay, the values must be translated to values on an evaluation scale. The evaluation scale is used as a way of reassigning different types of values in each theme to a common ranking. For example, you can not add a theme of soil type values (such as sand, gravel, or clay) to a theme of rainfall values (such as 1", 2.5", or 3.5") using the raw data. You convert the soil type values to a scale of 1=best to 3=worst. You also convert the rainfall values to the same scale of 1=best to 3=worst. Now you can weight and add the soil and rainfall values together to get an overall rank. 

You can define a default evaluation scale so that it will be presented in wizards and property sheets as the default choice. You can choose one of the predefined scales from the dropdown list, or you can create your own scale by choosing the From, To, and By values. 

Choose a predefined evaluation scale 

Click this radio button if you want to use a predefined scale. Select one of the scale choices in the dropdown list. 

Define a custom evaluation scale 

Click this radio button if you want to make your own evaluation scale. 

From 

If you are defining a custom scale, enter a number from 1 to 100 to specify the first value for your scale. 

To 

If you are defining a custom scale, enter a number from 1 to 100 to specify the last value for your scale. 

By 

If you are defining a custom scale, enter the increment. Each entry in the scale increments by this value. 

3.4 Building a model
A model is a collection of processes and connector lines directing the processing flow. To build a model, you add, edit, delete and connect processes in the model window. The links below describe how to work with processes and models in more detail. 

Adding a process 

There are two ways to add a process to your model: 

· Add a process using a wizard. 

· Add a process using drag-and-drop tools and property sheets. 

Editing a process 

There are two ways to edit a process: 

· Edit a process using a wizard. 

· Edit a process using property sheets. 

Deleting a process 

There are four ways to delete a process: 

· Select each node in the process using the Select tool [image: image178]and select Delete from the Edit menu. 

· Select each node in the process using the Select tool and press the Delete key on your keyboard. 

· Select each node in the process using the Select tool, right-click in the white space of the model window, and choose Delete from the menu. 

· Right-click on each node and select Delete from the menu. 

Deleting a process from the model window may have consequences for other processes in the model. 

Connecting and disconnecting processes 

There are two ways to connect and disconnect processes: 

· Connect and disconnect processes using a wizard. 

· Connect processes and disconnect using drag-and-drop tools. 

3.4.1 Adding a process
When you add a process to your model, it is represented in the model window by input data (either a project data node, or a derived data node from another process), a function node, a derived data node, and connector lines between the nodes. The process below contains project data named Elevation, a function named Slope, and derived data named Slope Map. It has connector lines showing the flow of processing. 
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There are two ways to add a process to your model. 

· Add a process using a wizard. The wizard asks you for the process properties, adds the process to the model window, and saves the property settings in the model file. The process is ready to run. 

· Add a process using drag-and-drop tools. You drag the nodes for a process into the model window, and connect them. The process is not ready to run because its properties have not been defined. You can define them using either the wizard or property sheets. See Editing a process for more details on setting the process properties. 

To add a new process using a wizard, select the process from the Add Process menu in ModelBuilder. Each wizard is a series of panels that ask you for all the properties required to run the process. The wizard fully defines the process and adds it to the model window. It does not run the process. 

First, the wizard collects information to define the input data. Each wizard shows you a list of input themes (or DEM files in the case of the DEM Conversion Process) that are of the appropriate data type(s) for the process. This includes themes in your ArcView project, and themes that are derived from another process (regardless of whether they have been created yet). If you choose a derived theme from another process, the wizard will automatically connect the two processes together when it finishes. 

To learn more about the appropriate data types for each process, see Data Requirements. To learn more about the available processes and what they do, see Model Processes. 

After collecting the input data information, the wizard asks you for properties required to process the input data. Then the wizard asks you for properties that affect the output data, such as the legend color and output theme name. To learn how to edit these properties, see Editing a process. 

Below is a Slope Process, created by a wizard, where the input data is data from an ArcView project. The nodes are filled with color because their property sheets are fully defined by the wizard. 
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Below is a Slope Process where the input data is derived data from a DEM Conversion Process. The two processes are automatically connected by the wizard. 
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To add a process using the drag-and-drop tools and property sheets, you click on the Add Function tool and click inside the model window. A function connected to derived data appears in the model window. The function and derived data nodes act in unison - you can never add or delete one without adding or deleting both. The nodes are in the not ready to run state. They are white because the function type and the properties have not been defined. (In this case, the default color for a node that is not ready to run is white. See Layout Symbols to learn how to change the color.) 
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By right-clicking on the function, you can define what type of process it represents. The node still appears white, because its properties have not been defined. 
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The function needs to be connected to input data. If you want to use the derived data from another process as input for this process, you can click on the Add Connection tool and drag a connection between the derived data of another process to the function. If the data type of the derived data is not suitable for the function, the connection will not be made. 

If you want to use a project data (data in the current ArcView project and not created by another process), you can click the Add Data tool and click in the model window. A project data node appears. You must define it by right-clicking on it and choosing the appropriate data type. 
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Using the Add Connection tool, you can drag a connection between the project data and the function. If the data type of the project data is not appropriate for the function, the connection will not be made. For example, if you try to connect project data that specifies a grid theme as input to a DEM Conversion function, the connection will not be created. (For more details about the data types accepted by each process, see Data Requirements). 

Even though you now have a complete process, the nodes are still white because the properties of the process have not been fully defined. The process is not ready to run. 
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Some processes, such as Weighted Overlay and Arithmetic Overlay, accept more than one input theme. The input themes can be any mix of project data and derived data from other processes. Below is a Weighted Overlay process that accepts one derived data input theme and two project data input themes. 
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You could define the properties for the process by right-clicking on the function and selecting Wizard, or you could right-click on each node and select Properties to open its property sheet. To learn more about editing the properties of a process, see Editing a process. 

3.4.2 Editing a process

When you edit a process, you change its properties. The properties for every process are stored in the model file (the model file is in the model folder and has an .xmd extension). When editing a process, be sure to consider how the changes will affect all other processes that may dependent on it. After you edit a process, the nodes in the model may change their symbols to reflect their new status. For more details, see Determining process status. 

There are two ways to edit a process: 

· Edit a process using a wizard. You can right-click on the function for a process and select the wizard. The wizard shows you the current property settings, and you can change them. When the wizard finishes, it updates the property sheets with the new settings. 

· Edit a process using property sheets. Each node in a process has its own property sheet that allows you to edit some of the process properties. You can right-click on any node in a process to open its property sheet. To edit all properties for a process, you edit the property sheet for each node. 

Editing a process using a wizard 

Process wizards walk you through all the current property settings of a process and allow you to change them as needed. To start the wizard for an existing process, right-click on the function for the process and select Wizard. Do not select the wizard from the Add Process menu in the ModelBuilder menu bar; this adds a new process instead of editing an existing one. 

Note that if you change the input data for a process, the wizard will disconnect the input data (either a project data node or derived data node) from the function and connect or create an input data node for the process. 

After finishing the wizard, the process is ready to run because all its properties have been defined. 

Editing a process using property sheets 

To edit a process using property sheets, right-click on the nodes in the process and select Properties. Or double-click the node. The property sheet appears, allowing you to change its current settings. The input data properties for a process can be edited in the property sheet for the project data node. The properties that affect processing can be edited in the property sheet for the function node. The properties of the output theme can be edited in the property sheet for a derived data node. 

Some processes support more than one type of input data. You may find that when you edit a project data for such a process, only the themes of the same data type as the currently selected theme will appear. If you want to choose a different type of data, you can delete and recreate the project data node, or use the wizard instead of the property sheets to edit the process. 

3.4.3 Deleting a process

To delete a process, you select it and delete it from the model window. Processes that are dependent on the output data from the process you deleted will not be ready to run until you provide them with alternative input data. 

You can delete all or part of a process. If you delete just the project data, the process will not be ready to run until you define new input data. Function and derived data nodes work in pairs. Both will be deleted together. 

You can delete a node by right-clicking on it and selecting Delete from the popup menu. 

To delete several nodes at once, first select them by clicking on the Select tool and clicking on nodes or dragging a box around the nodes. You can also choose Select All from the Edit menu to select every node in the model. 

You delete the selected nodes by clicking the Delete key on your keyboard, clicking the Cut tool in the toolbar, or selecting Cut or Delete from the Edit menu. If you choose Cut, the deleted nodes can be restored by choosing Paste. 

3.4.4 Connecting and disconnecting processes

Connector lines with arrowheads indicate the flow of processing through a model. Process nodes can be connected together using either a wizard or by drawing a connector line. In the wizards, if you specify input data that already exists in the model (either a project data or derived data node), the wizard will automatically draw the connection. Or you can click on the Add Connection tool and drag a connector line between the nodes. 
You can delete connections by choosing different input data in the wizard, or by selecting the connection with the Select tool, right-clicking on the connector line, and selecting Delete. You can delete connections between input data (either a project data or derived data node) and a function, but you can never disconnect a function from its derived (output) data. The function node and its derived data node act as a pair. They are added together and deleted together. 
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There are other restrictions that determine which connections can be added and deleted, based on the type of data a process can accept. 

Connecting and disconnecting undefined nodes 

When you are using drag-and-drop tools to create a model, you can create undefined nodes. They remain undefined until you set their properties. When both the input and function nodes are undefined, you can connect and disconnect them with no restrictions. 
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Connecting defined nodes 

When you define either the function or the project data, these definitions constrain your ability to connect nodes. This is because each function represents a spatial operation that is designed to work with a specific type of data. For example, the Point Interpolation Process is designed to work only with a point theme. If your input data node does not represent a point theme, you won't be able to connect it to the Point Interpolation function. 

Suppose the project data in your model has been defined as a DEM file, and it connects to two undefined functions. 

[image: image189.png]oo





If you defined the top function as a Reclassification function and the bottom as a DEM Conversion function, your model would look like this: 
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The connection between the DEM project data and the Reclass function has been deleted. This is because the Reclass function does not accept DEM files as input. If you try to add a connection between the DEM project data and the Reclass function, ModelBuilder will not allow the connection to be made. 

A disconnection occurs in your model automatically when ModelBuilder discovers that the type of data represented by the data node is incompatible with the data requirements of the function. Otherwise, existing connections are maintained. 

General connection rules 

· When the function is undefined, it can connect to any type of input data, whether it is undefined, theme data, or DEM data. 
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If you connect input data to functions in this way, you may create some invalid connections. In this particular example, ModelBuilder does not have any functions that can accept both a theme and a DEM as input. However, once you define the function, ModelBuilder will disconnect those inputs that are not appropriate to the function. 

· When the function is defined, it cannot accept undefined input. 
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· When both the function and input data are defined, they can connect only if the input data matches the data type requirements of the function. 
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Even though the project data in the graphic above has been defined as an ArcView theme and is connected to the Slope function, the process is still not ready to run. In the property sheet for the Theme node, you must choose the name of a theme that exists in the current ArcView project. When you choose the input data from the theme list, only those themes that can be processed by the function will be listed. If you also have to select a field from the theme table, only those fields that can be handled by the function are available for selection. For more information on theme types and functions, see Data Requirements. 

· If the input data is fully defined, it can only connect to undefined functions and functions that support the input data type (and possibly the input field type). In the example below, the project data is defined as a vector theme called "Vegetation.shp". The Buffer function accepts only grid themes as input. These nodes cannot be connected. 
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Disconnecting defined nodes 

You can always disconnect input data from a function, but you can never disconnect output data from a function. If you disconnect input data from a fully defined process, the function node may change its status from ready to run to not ready. Even though one or more nodes in a process may be ready to run, the process is not ready to run until all nodes are ready to run. See Determining process status for more information on process status. 

3.5 Navigating the model window
When you are building a model, you will probably zoom in and move around the model window as you work on detail areas, then zoom out work on the model as a whole. ModelBuilder provides menus and tools that allow you to zoom and an Overview window that allows you to move around the model. 

Zooming the model 

There are many ways to zoom in and out in the model window. To zoom in to a smaller area of the model, you can select Zoom In from the View menu, or click the Zoom In tool. This zooms in on the center of view, magnifying the objects in the center and decreasing the portion of the model displayed in the model window. To zoom in by an amount you select, click the Zoom tool and drag a box around the area you want to zoom to. To zoom out, select Zoom Out from the View menu or click the Zoom Out tool. 

To magnify or reduce the model in proportion to its actual (printed) size, select one of the percentages (25%, 50%, 200%, 400%) listed in the View menu, or choose Custom Zoom and enter a percentage. If you select a percentage less than 100%, the nodes in the model appear smaller than actual size. If you select a percentage greater than 100%, the nodes appear larger. To reset the model to its actual size, select Actual Size from the view menu. 

Fitting the model in the window 

Click the Full View tool or select Full View from the View menu to zoom in or out so that the entire model just fits in the current window. 

Using the Overview window 

You can use the Overview window to select how much of your model you want to view in the model window. To open the Overview window, select Overview from the View menu. A small window showing your entire model appears. Hold down the left mouse button and drag a selection box around the part of the model you want to view. The model window zooms to the area inside the selection box. You can drag the selection box you drew in the Overview window to display different parts of the model. You can resize the selection box by dragging one of the handles (the small black squares on the perimeter of the selection box). Or you can create a new selection box. 
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The title of the Overview window is the print caption. To set the print caption, choose Model Documentation from the Model menu and click on the Caption tab.

3.6 Saving a model

Your model is saved when you choose to save it; it is also automatically saved when you run the model. Each time you click the Save button or choose Save from the ModelBuilder File menu, all changes to the model are saved. If you exit ModelBuilder and there are unsaved changes in the model, you will be prompted to save the model. 

Creating a model folder 

When you save your model for the first time, a model folder is automatically created with the same name as the model. The model file is saved in the model folder. You cannot save more than one model in a model folder. For a list of the files that are created when you save a model, see Sharing a model. 

When you run a model, the output data created by the model is also saved in the model folder. The input data for a model does not have to be in the model folder; ModelBuilder lets ArcView manage the input data. 

Making a copy of a model 

If you use the Save As choice in the ModelBuilder File menu, you can rename your model. This leaves the original model intact and makes a copy of it under the new name. A new model folder is also created. If the model name already exists, you will get an error message. Any output data created by running the new model will be saved in the new model folder. For more information about saving a model under a new name, see the Save Model As help. 

Save Model As
The Save As choice in the ModelBuilder File menu opens the Save Model As window. It allows you to create a copy of your model under a different name. A new model folder and a model file are created with the new name. Only one model can be saved in a model folder. You will get an error message if you try to rename a model to a name that already exists. 
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All edits you make to the model after renaming it will be saved under the new model name. The old model and old output data are not changed. 

When you run your model, the new output data is saved in the current model folder. The input data can be stored anywhere. 

Drives 

Choose the disk drive where the copy of the model will be saved. 

Save in 

Choose the folder on the disk drive where the new model folder will be created. 

Model name 

Enter the new name of the model. If this name already exists, you will get an error message when you click Save. In this case, choose a different model name. 

Model will be saved to 

At the bottom of the Save Model As popup window, the full path and name of the new model file is listed.

3.7 Running a model

You can run an entire model or part of a model. Whenever you run a model, changes to the model are automatically saved. There are several ways to run a model: 

· When you click the Run button or choose Run Model from the Model menu in ModelBuilder, only those portions of a model that have not been run will run. 

· When you right-click on the function node of a process and choose Run, or you click the Run button on the property sheet for the function node, that process will run. If the selected process is dependent on other processes and they have not run yet, they will also run. If there are processes later in the model that are dependent on the selected process and they have already been run, their state will change from already run to ready-to-run. 

· When you want to run all the processes, regardless of whether they have been run before, you can choose Run Entire Model from the Model menu. For details on how to determine whether a process has been run or is ready to run, see Determining process status. 

Creating output data 

When you run a model, the output data is created and the model is automatically saved in the model folder. The output data is also added as a theme in ArcView. ModelBuilder tries to add the output theme to the view that was active when the ModelBuilder window was opened. If that view has been deleted or the name has changed, ModelBuilder will create a new view and add the output themes there. 

If you choose to run processes that have already been run, ModelBuilder will overwrite the output data created from the previous run. It will delete the old output theme from ArcView and replace it with the new theme. If you do not want ModelBuilder to overwrite your old output data, you can choose Save As in the ModelBuilder File Menu and save the model under a new name. This will create a new model folder and a copy of the model under the new name. When you run the model, the output data will be created in the new model folder, leaving the existing output data alone. The old and new output themes will both appear in your ArcView project. 

3.8 Revising a model

There will be many occasions when you will want to revise your model. You may wish to run a model using a different input theme. Or you may want to alter model settings to see their impact on the model results. Perhaps you just want to change the theme name of your output data. ModelBuilder provides property sheets and wizards that make such changes very easy to do. However, there are some issues you need to keep in mind when you are revising a model. 

Making a copy of your model 

Before you revise a model, you might want to make a backup copy of it. To do this, save your current model under new name using the Save As choice in the File menu. This creates a new copy of the model and a new model folder. Then you can experiment with the new model freely, knowing that the original model is safe in its own model folder. 

Changing a process using wizards 

To revise a model, you edit the processes within the model. One way to edit the entire process is to right-click on the function node for that process and select Wizard. The wizard will walk you through all the process properties, including the input data properties, function properties, and output data properties. Each wizard panel will show you the current property settings, and you can change them or leave them as is. 

Changing a process using property sheets 

Another way to edit a process is to edit the property sheets for a process. A process is represented by nodes, and each node has a property sheet that can be edited. Every process has a function node, which represents the spatial processing to be done, and a derived data node, which represents the output data created by the process. A process may have a project data node, which represents the input data, or it may use the derived data node from another process as its input. You can open the property sheet for any process node by right-clicking and selecting Properties. 

Changing input data properties 

If you open the property sheet for a project data node that is not connected to a function node, you can select any input theme and any field in the theme. Once project data is connected to a function, you can only select input themes and fields appropriate to that function. If you cannot connect project data to a function, it probably has the wrong type of input for that function. In this way, ModelBuilder keeps you from inadvertently creating an invalid model. 

To change the input data for a process, right-click on the project data node and select Properties. In the property sheet you can change the input theme (or DEM file) or select an input field (where appropriate). However, the property sheet theme dropdown list will only give you access to those themes that are the same data type as the currently selected theme. In some cases, the process may accept other data types, but the data type is restricted to the current data type. You can use the wizard or you can delete the project data node and add a new one to choose another supported data type. 

You may also discover that not all of the fields in the selected theme are listed in the Project Theme Property Sheet. This is because ModelBuilder determines which fields are of the appropriate type for a process. Only those fields are displayed in the field drop down list. 

For more information on data types, see Setting up data for ModelBuilder. See Data Requirements for a list of the data types accepted by each process. 

Changing Function Properties 

You can change function properties using the function wizard or property sheets. Each function has its own set of properties required for processing. If you make a mistake in the changes, you can go back and manually reset the properties, or you can close the model without saving it, then reload the model. If you run the model, the changes are saved automatically. In this case, if you want to revert back to previous function property settings you will need to reset them manually. 

Changing Output or Derived Data properties 

Derived data properties include the extent, cell size, and legend of the output theme, the theme name and the name of the file that is used to store the data on disk. These properties can be accessed through the Derived Data property sheets or the wizard. 

The theme name displays in the table of contents of the view, and changing that is pretty straightforward. Changing the file name, however, has a restriction. ModelBuilder will only allow unique file names for derived data. This is needed to keep the created data from being corrupted within the model. 

Changing the connections 

Connector lines connect the nodes in a model, and they have arrowheads indicating the flow of processing. You can disconnect one process from another by right-clicking on the connector line between the derived data of the first process and the function of the second process and selecting Delete. You can also disconnect project data from a function by deleting the connector line. When you disconnect processes or project data, the color of the nodes may change to white, indicating that the process is not fully defined. 

You can add connections between data and functions using the Add Connection tool. If you cannot draw a connection between two nodes, the data may be the wrong type for that function, the function may already have its maximum number of input data sets. See Connecting and disconnecting processes for more details. 

3.9 Printing a model

You can print a model to a printer or save it to a graphic file in the model folder. You print a model by choosing Print from the File menu in ModelBuilder. A graphic file (.bmp) of a model is created or updated every time you save the model. You can set up printing and graphic file properties by choosing Print Setup from the File menu. 

To learn more about the Print Setup options, see the following topics. 

To Printer tab - Set up the margins, page numbers, border, crop marks, and scale of the printout. 

To Graphics File tab - Set the scale of the model in the graphic (.bmp) file. 

3.9.1 Print Setup To Printer tab
On the To Printer tab, you can set the scale and margins of the printout. The check boxes determine whether the page numbers, the model caption, a border, and crop marks appear on your printouts. The Print Setup window does not actually print the model. After you change the setup, you must choose Print from the File menu to print the model. 
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Scale By 

If you choose the Scale By Pages selection on the To Printer tab, the model is scaled to print using the number of pages across (Page Columns) and down (Page Rows) you specify. The Actual Size selection prints the model at actual size, regardless of the number of Page Rows and Columns set. 

Margins 

Enter the margin width in inches in the Margins textbox. The margin width is the same for all sides. 

Print Page Numbers 

Check this box to print the page numbers on the page. The page numbers only appear if the diagram uses more than one page. The page numbers appear in the center of the margins of the sides of the page that touch other pages. They are in the format [Row, Column]-Location, where Row is the row page number, Column is the column page number, and Location is top, bottom, left, or right. In the example below, [2,1]-R is the page number in the margin on the right side of the page in the second row, first column. [2,2]-T is the page number in the top margin on the second page in the second row. 
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Print Model Caption 

Check this box if you want the model caption to print in the lower right corner of the model. You can set the model caption by selecting Model Documentation from the Model menu, clicking the Caption tab, and entering the caption. 

Print Border 

Check this box if you want a single-width border (sometimes called a neatline) drawn at the margin edges. 

Print Crop Marks 

Check this box if you want crop marks to appear along the sides of your pages. Crop marks appear as a single-width line about 1\2 inch long on the edges of a page that touch other pages. Crop marks are useful for aligning diagrams across several pages. The example below shows cropmarks. 
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Default 

To restore the default settings, click the Default button.
3.9.2 Print Setup To Graphic File tab

Each time you save a model, a graphic (.bmp) file by the same name as the model is saved in the model folder. You can use this graphics file in an ArcView layout or in any graphics software that accepts .bmp files. 
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Scale Percent 

On the To File tab, you can set the scale percent to determine how large the graphic file will be relative to the size of the model. 

Default 

To restore the default settings, click the Default button

3.10 Importing a model

ModelBuilder allows you to bring other models into your current model. Importing is useful for aggregating smaller models into larger, more comprehensive ones. Modeling done on a local level can be aggregated into regional models and regional models into those larger in scope. 

To import a model, choose Import Model from the File menu. This opens the Import Model window. Navigate to the model folder, then highlight the model file you wish to import and double-click it. 
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If you wish to remove an imported model, you can select the model components you wish to delete using the Select tool [image: image202]. Once selected, you can delete them by selecting Delete from the Edit menu or by pressing the Delete key. 

Resolving duplication issues 

When you import a model, ModelBuilder determines which nodes have duplicate names and which ones represent the same theme and field in ArcView. Suppose you have Model 1, which generates aspect data, and Model 2, which generates slope data. Both models have a project data node called "Elevation", which represents the same elevation theme and field in ArcView. 
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When a model with a duplicate input theme is imported, the duplicate project data node is removed and the connections in the model are adjusted. When you import Model 1 into Model 2, the results look like this: 
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If the project data nodes had different names, they would still be combined into one node if they represented the same theme and field in ArcView. If they represented the same theme, but a different field within the theme table, they would not be combined. 

Now consider the case where you are importing two models that have the same project data node names, but they actually represent two different themes (or the same theme but different fields in the theme table). They also have duplicate derived data node names: 
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When you import Model 1 into Model 2, the results look like this: 
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Both project data nodes appear in the combined model since they represent different themes. The imported node has a "2" appended to its name to make it unique. The imported derived data node also has a "2" appended to its name to make it unique. You can change these automatically generated names by right clicking on the node, selecting Properties, and entering a new name for the node. 

ModelBuilder also scans the filenames of the derived data looking for duplicates. It appends a number to any imported duplicate filenames to make them unique. This ensures that when data is written to disk, it does not overwrite any other model data.

3.11 Exporting a model

ModelBuilder gives you the ability to export all or part of a model to a model file. The ability to export a portion of a model is useful when you have a large model and want to share only a portion of it. 

When you export the model or model portion, a new model folder and a new model with a different name are created. Once exported, the model can be distributed for import into other models. For information about the files you need to distribute when you share a model, see Sharing a model. 

If you do not select any nodes in the model, the entire model will be exported (it works the same as the Save As menu choice in this case). If any portion of the model is selected, only the portion is exported. You need only select the last node in the portion of the model you want to export, because all processes on which it is dependent will automatically be exported as well. 

An example of exporting a model 

In order to export a model, you select a portion of the model by clicking the Select tool and clicking on the nodes you would like to export. The selected nodes will be outlined with dashed lines. In the model below, the buffer function has been selected. 
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Choose Export Model from the File menu. This opens the Save As popup window. Navigate to the folder where you wish to save the exported model, enter a new model name, and click OK. A model folder is created with the same name you entered for the exported model. The model is saved in the standard xmd format. Refer to Saving a Model for more information. Below, a portion of the model is exported to a new model called "ProtectedZonesModel". 
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Although only the Buffer function was selected, the Vector Conversion function on which it depends is exported as well. The exported model looks like this: 
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Selecting project data for export 

Clicking on project data node will export only the nodes you have selected. If you wish to select more that one node, you can either drag a box around the nodes you desire, or hold down the Shift key and select the nodes individually. 

Selecting a function for export 

Clicking on a function node will export the entire process, including the input data, the function, its derived data, and all preceding processes that input into the function. 

Selecting derived data for export 

Selecting a derived data node for export will also export the entire process that creates the derived data and any preceding processes that are required to produce the derived data for export. For example, if you selected the "Potential drill sites" derived data node in the first model above, the entire model would be exported.

3.12 Sharing a model

You might want to share a model you created in ModelBuilder. Having the ability to share a model has some important benefits: 

· Specialized models can be created by experts, then the model can be used by others with less expertise in the specialized application. 

· Models can be used over and over again, reducing development costs. 

· Standardized spatial analyses can be captured in a model, then users can substitute their own local data into the standard model. 

· Models can be imported into other models, allowing teams to create separate models, later joining them together. 

Sending the model to others 

You can send a model file as an attachment to an email, or transfer it as you would any other file. 

You will find the model file in the model folder. There are also some files associated with the model (see the table below). You can choose to share just the model file or the model file plus its associated files. 

	Extension
	File type
	Description
	Required for sharing?

	.xmd
	Model file
	This file contains the process properties and instructions to execute the model.
	Required

	.mdl
	Layout file
	This file saves the position of nodes as they were last saved. If it is not available, the model will use automatic layout to place the nodes.
	Optional

	.xmp
	Preferences file
	This file contains symbology and layout preferences, such as node colors, height and width, text fonts, model orientation, spacing between nodes, and geometry of connector lines. If it is not available, the model uses default symbology and layout properties.
	Optional

	.log
	Log file
	When the model is run, a log file documents whether the model loaded correctly and whether each process was successful. This file is overwritten every time you run the model
	Optional

	.bmp
	Graphic file
	This file is a graphic of the model. It is used to print the model.
	Optional


If the model has been run, the model folder also contains the derived data files and directories. You can choose whether share the derived data. If you want to share the data, be sure to include the info folder. It contains information required for grid themes. 

Setting up a new model workspace 

When you receive a model file, you should create a model folder to store the model file. The model folder is the working area for the model, and all output data created by the model will be stored there. 

If input data is provided, you do not need to store it in the model folder; you can store it in a separate location. You must add the input data as a theme in the current ArcView project before the model can run. The only exception to this is the DEM Conversion Process, which accepts a file on a disk drive as input. 

Opening the Model 

When you open the model, ModelBuilder will check to see if the project data is in the current ArcView project (except for DEM files). If the data is not found, then the project data node representing the input data is not ready to run, indicating that the model cannot find the input data. Any function or derived data nodes that are dependent on the project data node are also not ready to run. In the graphic below, the Airport.shp theme has been removed from the ArcView project. The Vector Conversion and Buffer processes that depend on the Airport.shp theme are not ready to run. The nodes change their symbology to reflect their "not ready" state. 

[image: image210.png]Airports

Birpart arid

Naise bufer





If the model does not find the input data, you must redefine the input data in the project data node by following these steps: 

· Right-click on project data node and select properties. This opens the Project Theme property sheet. 
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· In the Choose the Input Theme drop down list, select the input theme (if it is a DEM file, you are prompted to load the file from your disk drive). In the Choose the Input Field drop down list, select the input field. Click OK. If a field is not listed, it may not be the appropriate data type for the process. If your input theme is not in the list, may not be in your current ArcView project, or it may not be the appropriate type of data for the process. You may have to run a Data Conversion or Reclassification Process to convert the data to the appropriate type. See Data Requirements for a list of the data requirements for each process. 
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The symbol for the project data node changes to indicate that the input data has been located. The nodes that depend on the project data node also change their status. 
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A word of caution: If you change the input data, review all of the other functions that depend on that data as input. Do this to make sure that the subsequent output data will provide the type of output you want the model to produce. 

Guidelines 

· When sharing a model, document it thoroughly before it is shared. 

· If you are not providing input data with the model, be sure to give your users instructions on the data they must provide to run the model. 

· Documentation is also necessary if you make changes to a shared model. See Setting up model defaults and documentation for more information on documenting your model. 

· Don't attempt to edit a model outside of ModelBuilder. 

3.13 Adding text to a model

You can add text to the model by clicking on the Text tool and clicking inside the model. A text node represented by a dashed rectangle with the word "Text" appears. To change the text, double-click on it, type your new text in the Text window, and click OK. To move text, select it using the Select tool and drag it to a new location. 

The default properties for text nodes, such as font, size, and color, are set by choosing Layout Symbols) in the View menu. You can change the properties for an individual text node by double-clicking on it and clicking on the Text Properties tab in the Text window. 
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Text Font 

Click on the button to the left of the current text font selection to open the Font window. Choose a font type, style and size. For international fonts, choose a script type. The fonts that are available on your machine will be listed in the Font selection list. The font sizes are measured in points. In the Sample window, you can see what your selections will look like. Click OK to apply the changes. 
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Text Color 

Double-click the selected color to open the Color window. Select a color by clicking on one of the basic colors, dragging the crosshairs in the color palette, or entering the color values. The color you choose will appear in the Color|Solid box. Click OK. 
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Background color 

You can change the color of the text node by double-clicking in the Background Color box and selecting a new color in the Color window. 

Outline Width 

The outline width is set to a point size of 1 by default. You can make the outline thicker by increasing the number in the selection box. Decreasing it reduces the width of the outline. 

Outline Color 

You can change the color of the text node outline by double-clicking in the Outline Color box and selecting a new color in the Color window. 

Shadow 

Check the box next to Shadow to turn the text node shadow on and off. The shadow color and outline width determine how much the shadow stands out visually. A shadow gives the text node a raised look. The offset of the shadow determines how high the text node appears to be raised. 

Shadow Color 

You can change the color of the shadow by double-clicking in the Shadow Color box and selecting a new color in the Color popup window. 

Shadow Outline width 

The shadow outline width is set to a point size of 1 by default. Increasing the point size makes the shadow outline thicker. 

Shadow Outline Color 

The shadow outline determines how distinctive the shadow will be. To change the shadow outline color, double-click on the color box and select a new color in the Color window. For a subtle shadow with no outline, set the shadow outline color to the same color as the shadow. 

Shadow X-Offset 

Use the Shadow X-Offset to determine how much of the shadow will show in the horizontal direction. When the X-Offset is 0, the shadow is aligned with the text node in the horizontal direction. Increasing the Shadow X-Offset value moves the shadow to the right of the text node; decreasing it moves the shadow left. 

Shadow Y-Offset 

Use the Shadow Y-Offset to determine how much of the shadow will show in the vertical direction. When the Y-Offset is 0, the shadow is aligned with the text node in the vertical direction. Increasing the Shadow Y-Offset moves the shadow down from the text node; decreasing it moves the shadow up. 

3.14 Changing the model layout and symbols

You can change the way your model looks by changing the layout properties and the node symbology. The layout properties affect where nodes will be placed in the model. You can turn automatic layout on or off, and you can define how nodes are spaced and how connector lines are drawn between them. The node symbology affects the color, size, and text of nodes in the model. You can define symbology for each state of a node (not ready to run, ready to run, or already run). 

The layout properties and node symbology are saved in the model folder in a file with a .xmp extension. If you delete this file, the model will use default settings. When you share a model, you can optionally share the .xmp file to keep the current layout preferences. When you create new models, you can copy the .xmp file to reuse the settings. 

To change the layout behavior, choose Layout Properties in the View menu. The Layout Properties window has two tabs, General Options and Layout Options. Click the links below to view the help for each tab. 

General Options tab - Turn automatic layout on or off. Set spacing for manual mode. 

Layout Options tab - set the parameters for automatic layout. Set the flow direction of the model, node spacing, and connector line geometry. 

To change the node symbology, choose Layout Symbols in the View menu. Click on the link below to view the help for the Layout Symbols window. 

Layout Symbols - set the node color, height, width, shadowing, and text properties. 

3.14.1 Layout Properties - General Options tab
To configure the General Options for the layout, choose Layout Properties from the View menu and click the General Options tab. When you are building a model, you can have ModelBuilder choose the placement of nodes for you, or you can manually place them yourself. The General Option tab in the Layout Properties window turns automatic layout on or off. 
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Layout Mode 

Click Automatic to enable automatic layout. Click Manual to disable automatic layout. If you disable Auto Layout, you will get an error message when you click the Auto Layout tool, and the node placement will not be adjusted when you add new nodes. 

Snap Nodes to Grid 

Click Snap Nodes to Grid if you are in Manual mode and you want the node centers to snap to an invisible grid in the model window. This option is not available in Automatic mode. 

Grid Height and Grid Width 

If you are in Manual mode and you have checked Snap Nodes to Grid, you can set the spacing of the invisible grid in the model window. The node centers will snap to the intersections of the invisible grid lines. This option is not available in Automatic mode. 

Load 

Click the load button to load a preference (.xmp) file. When you save a model, a preference file is saved in the model folder. You can load a preference file from one model into another model. You can also create standard preference files that you load into each new model. 

Save 

Click the Save button to save your preference settings to a preference (.xmp) file. The preference file also gets saved every time you save the model. Preference files from any model may be loaded into another model. 

Apply 

Click the Apply button to apply any changes to the layout settings to the model.

3.14.2 Layout Properties - Layout Options tab

To change the layout options, select Layout Properties from the View menu and click the Layout Option tab. The Layout Options tab in the Layout Properties window controls model orientation, spacing, alignment and connector line behavior. 
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Orientation 

By default, processing in a model flows from left to right, as indicated by the arrowheads on the connector lines. You can change the model to flow from right to left, top to bottom, or bottom to top. Choose Layout Options from the View menu, choose the orientation, and click the Apply button. 
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Incremental Layout 

Incremental Layout minimizes the amount of change when ModelBuilder automatically adjusts the layout. Only the latest additions to the model since the last automatic layout are adjusted. To turn on Incremental Layout, check Active. If Active is checked, you can also check Reduce Crossings. Reduce Crossings tries to bend and reroute connector lines so that they cross as little as possible. This option takes longer to draw. 

Minimum Spacing 

If you check Variable Level Spacing, the horizontal spacing between the nodes is adjusted as needed by the automatic layout. If you do not check Variable Level Spacing, you can set the vertical and horizontal spacing to fixed values. The Between Nodes setting affects the vertical spacing. The Between Levels setting affects the horizontal spacing. 
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Level Alignment 

In some cases, your model may have several nodes in one branch, but only a few nodes in another branch. By choosing the level alignment, you can specify whether the branch with fewer nodes aligns towards the output side or input side. Project data nodes always align towards the input side. Select Towards Input to align function and derived data nodes towards the input side of the model. Select Towards Output to align function and derived data nodes towards the output side of the mode. 
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Minimum Slope 

The Minimum Slope choice is only available if Variable Level Spacing and Orthogonal Routing are turned off. The Minimum Slope determines the minimum angle, in degrees, of a diagonal connector line. 
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Edge Clipping 

The connector lines between nodes can point towards the center or edge of a node. 
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Edge Routing 

Click Orthogonal Routing to make connector lines rectilinear instead of diagonal. 
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Click Merge Rows to make vertical lines meet at the same point. 
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If you have Variable Level Spacing in Minimum Spacing turned on, you can also specify the Row Spacing (vertical spacing between nodes) and Column Spacing (horizontal spacing between nodes). 

Load 

Click the load button to load a preference (.xmp) file. When you save a model, a preference file is saved in the model folder. You can load a preference file from one model into another model. You can also create standard preference files that you load into each new model. 

Save 

Click the Save button to save your preference settings to a preference (.xmp) file. The preference file also gets saved every time you save the model. Preference files from any model may be loaded into another model. 

Apply 

Click the Apply button to apply any changes to the layout settings to the model. 

3.14.3 Layout Symbols
You can change node size, text, color, outline width, and shadowing to create a distinctive model. There are four types of nodes that you can edit - Project Data, Function, Derived Data, and Text nodes. Except for Text nodes, each node has three states: not ready to run, ready to run, and has been run (See Determining process status for more details about node states). You can define different symbology for each node in each state. This allows you to determine the status of your model at a glance. 

To change the symbols, select Layout Symbols from the View menu. Select the node type (Project Data, Function, Derived Data, or Text). If this is not a text node, select the state (Not Ready to Run, Ready to Run, Has Been Run). In the example below, the current symbol is shown in the Node Preview window. As you change the settings, you will see the symbol change in the preview window. The Node Type and Node State above the preview window indicate which symbol you are working on. 
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Changing colors 

For any of the colors boxes (Text Color, Background color, Outline color, Shadow color, and Shadow outline color), you double-click on the color box to open the Color window. You can select a new color by clicking on a basic color. Or you can click on any color in the rainbow palette and set the shade of the color by dragging the triangle next to the grayscale bar on the right. You could also type in the Hue, Saturation, and Luminescence values, or the Red, Green, and Blue values, depending on which color model you use. 
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Text Font 

Double-click the Text Font box to open the Font window. Select the font, style, and size of text inside the node. The fonts that are available on your machine will be listed in the Font selection list. The font sizes are measured in points. In the Sample window, you can see what your selections will look like. Note that if you are on the Text tab, you are setting the default properties for free-standing text nodes. You can override the default properties for each individual text node. You cannot do this for other types of nodes. See Adding text for details about changing the text properties of individual text nodes. 
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Text Color 

You can change the color of text by double-clicking in the Text Color box and selecting a new color in the Color window. 

Height and Width 

Set the height and width for the node. If you change the height and width for one state of the node, it is usually best to make it the same for all three states. Text nodes do not have a height or width. 

Background color 

You can change the color of the node by double-clicking in the Background Color box and selecting a new color in the Color window. 

Outline Width 

The outline width is set to a point size of 1 by default. You can make the outline thicker by increasing the number in the selection box. Decreasing it reduces the width of the outline. 

Outline Color 

You can change the color of the node outline by double-clicking in the Outline Color box and selecting a new color in the Color window. 

Shadow 

Check the box next to Shadow to turn the node shadow on and off. The shadow color and outline width determine how much the shadow stands out visually. A shadow gives the node a raised look. The offset of the shadow determines how high the node appears to be raised. 

Shadow Color 

You can change the color of the shadow by double-clicking in the Shadow Color box and selecting a new color in the Color popup window. 

Shadow Outline width 

The shadow outline width is set to a point size of 1 by default. Increasing the point size makes the shadow outline thicker. 

Shadow Outline Color 

The shadow outline determines how distinctive the shadow will be. To change the shadow outline color, double-click on the color box and select a new color in the Color window. For a subtle shadow with no outline, set the shadow outline color to the same color as the shadow. 

Shadow X-Offset 

Use the Shadow X-Offset to determine how much of the shadow will show in the horizontal direction. When the X-Offset is 0, the shadow is aligned with the node in the horizontal direction. Increasing the Shadow X-Offset value moves the shadow to the right of the node; decreasing it moves the shadow left. 

Shadow Y-Offset 

Use the Shadow Y-Offset to determine how much of the shadow will show in the vertical direction. When the Y-Offset is 0, the shadow is aligned with the node in the vertical direction. Increasing the Shadow Y-Offset moves the shadow down from the node; decreasing it moves the shadow up. 

Part 4: Model Processes

Processes are the building blocks of a model. They perform a spatial operation on input data to produce output data. A model may be a single process, or it may contain many processes chained together. You add processes to your model by selecting one of the wizards in the Add Process menu, or by building a process using the drag-and-drop tools. Properties for each process are stored in the model file. For more details on adding and editing processes and their properties, see Building a model. 

4.1 Data Conversion Processes

ModelBuilder supports three Data Conversion processes, Vector Conversion, DEM Conversion, and Point Interpolation. To learn more about a particular process, click on its name. 

Vector Conversion Process (Vector to Grid) 

The Vector Conversion Process converts a point, line, or polygon vector theme to a grid theme. The resulting grid theme can be used as input to other processs such as Reclassification, Buffer, or Weighted Overlay. 

DEM Conversion Process (DEM to Grid) 

The DEM Conversion Process converts a standard USGS DEM file into a grid theme. DEM files are read from your disk drive because they cannot be added into ArcView directly. 

Point Interpolation Process 

The Point Interpolation Process creates a continuous grid theme that represents a surface by interpolating the measured values in a point theme. This process is often used to create an elevation surface grid theme from measured elevation points. The grid theme is commonly used as input to the Terrain, Reclassification, and Arithmetic Overlay Processs. 

4.1.1 Vector Conversion Process
In ArcView, you have the Parcels theme loaded. This is the polygon theme that will be converted to a grid theme. 

1. Specify the input theme and field
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In the ModelBuilder window, you start the Vector Conversion Process Wizard. It prompts you for all the properties required to define the input data, the method for converting cell values, and the output data. First, it prompts you for the input theme and field. The input theme must be a vector (point, line, or polygon) theme in the current ArcView project. You select the Parcels theme from the dropdown list. For the input field, you choose Stories. This is a numeric field containing the number of stories in each developed parcel (building). 
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2. Define the data type

After choosing the input theme and field, the wizard prompts you to choose the type of classification. Since the input field (stories) is integer, you must specify whether the values in the field represent numeric values or categories. If you choose Numeric Values, the input values are grouped into ranges. In this case, you choose Categories because you want a unique class for each value. Each value is a category that represents the number of stories. 
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In the next screen, you see the classification table with one class for each unique value. The Existing Class Value is the number of stories. You want to assign these values to cells in the output theme (New Class Value), so you won't change these values. You will edit the labels for the output theme's legend. 
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3. Define the color scheme, extent, and cell size

Next, you choose the Pastels color scheme for the output theme's legend. Then, you specify the extent of the output theme to be the same as the input theme (Parcels). Since no default cell size was set for the model, and the input theme does not have a cell size because it is not a grid theme, ModelBuilder calculates a cell size for the output theme based on the extent of the input theme. For the cell size, you choose the default cell size calculated by the wizard, 7.112875 meters.
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4. Finish the wizard and add the Vector Conversion Process to the model

You document the Vector Conversion Process by recording descriptive comments. Finally, you name the output theme and file, and click Finish.
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The Vector Conversion Process you defined is added to the model. 
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5. Run the Vector Conversion Process

The Vector Conversion Process is ready to run. To run the process and create the parcels grid theme, you click the Run button. 
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The Vector Conversion Process creates the Stories Grid theme. The theme is added in ArcView. You see where the tallest buildings are located. Because the No Data symbol is transparent, these areas appear white in the view. You can use the Stories Grid theme as input to the Arithmetic Overlay Process to calculate the Lake Tahoe canopy. Below, the parcel outlines are displayed on top of the Stories Grid theme to add definition.
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4.1.2 DEM Conversion Process

1. Specify the input DEM file

In the ModelBuilder window, you start the DEM Conversion Process Wizard. It prompts you for all the required properties to define the input data and the output data. First, it prompts you for the DEM file that will be converted to a grid theme. You select the elevation.dem file from your disk drive. This DEM file contains elevation values for the area.
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2. Define the legend table
After choosing the input DEM file, the DEM Conversion wizard presents a default classification for the output theme's legend. The values are elevations measured in meters. The elevation values are divided into 5 equal interval classes. 
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You want to create 9 classes, each containing approximately 100 meters of elevation change, and you want to round the values to whole numbers, making the legend easier to read. To do this, you click the Classify button. In the Classification wizard, you change the number of classes from 5 to 9 classes and change the number of decimal places from 3 d.ddd to 0 d (0 decimals) using the lower dropdown list. 
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After you click OK, the legend table is updated to reflect your changes. 
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3. Define the output theme color, extent, and cell size
You choose the default color scheme for the output theme, a standard elevation color ramp. Then, you specify the extent and cell size of the output theme to be the same as the input file, elevation.dem.
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4. Finish the wizard and add the DEM Conversion Process to the model

You document the DEM Conversion Process by entering a web site address (URL) for the USGS web site for downloading DEM files. Finally, you name the output theme and file, and click Finish.
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The DEM Conversion Process you defined is added to the model. 
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5. Run the DEM Conversion Process

The DEM Conversion Process is ready to run. To run the process and create the elevation map, you click the Run button. (Alternatively, you could run the model by choosing Run Model on the Model menu or right-clicking the function node.) 
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The DEM Process creates the DEM Map theme. This theme is added in ArcView. You can use the DEM Map theme as input to other ModelBuilder processes to create slope, aspect, hillshade, and contour maps for your erosion model. 

4.1.3 Point Interpolation Process

1. Specify the theme and field to be interpolated

In ArcView, you have a point theme called "Soil Samples". Each point in the theme records the soil pH at that location.
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In the ModelBuilder window, you start the Point Interpolation Process Wizard. It prompts you for all the properties required to define the input data, the method for interpolating cell values, and the output data. First, it prompts you for the input theme and field. The input theme must be a point theme in the current ArcView project. You select the Soil Samples theme from the dropdown list. For the input field, you choose Ph. This field contains the pH value for each soil sample location.
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2. Define the interpolation method and properties
After choosing the input theme and field, the wizard prompts you to choose the interpolation method. The IDW (Inverse Distance Weighted) interpolation method, the default, is a good choice in this case because the soil sample point locations occur at regularly spaced intervals and you want all cell values in the output theme to fall within the minimum and maximum input pH values. The Spline interpolation method would be a better choice for irregularly spaced data, and it may calculate output cell values that overshoot or undershoot the input point values.
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In the next screen, you choose the properties for the IDW method. By default, 12 sample points (nearest neighbors) will be used to estimate the value of each cell in the output theme. This is the best choice for your regularly spaced sample data. Because you want the closest sample points to have more influence on the estimated value, you increase the Power of distance value to 4.
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3. Define the output theme legend
Next, you choose the number of classes for the output theme's legend. The default legend has five (5) equal interval classes.
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Based on the range of pH values, you want six (6) equal interval classes. You click the Classify button and increase the number of classes to 6. Because the cell values represent pH, you round them to one (1 d.d) decimal place.
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The legend table is updated to reflect your choices.
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4. Define the output theme color scheme, extent, and cell size

Next, you choose the green monochromatic color scheme for the output theme's legend.
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You set the extent of the output theme to be the same as the input theme (Soil Samples). For the cell size, you choose a cell size of 2 (meters).
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5. Finish the wizard and add the Point Interpolation Process to the model
You document the Point Interpolation Process by recording descriptive comments. Finally, you name the output theme and file, and click Finish.
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The Point Interpolation Process you defined is added to the model.
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The Point Interpolation Process is ready to run. To run the process and create the pH surface, you click the Run button. (Alternatively, you could run the model by choosing Run Model on the Model menu or right-clicking the function node.)
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The Point Interpolation Process creates the Point Interpolation Map theme. The theme is added in ArcView. You see where the most alkaline (high pH) and the most acidic (low pH) soils are located. You can use the surface to calculate the prescription for applying chemicals to the soil only where they are needed. Below, the sample points are displayed on top of the pH surface to add information.
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4.2 Terrain Processes

4.2.1 Slope Process
You want to create a slope map for an area as part of an erosion analysis model. Slope maps are often used in erosion studies because steeper slopes are generally associated with higher erosion rates. You have an elevation theme that you will use as input. The Slope Process will use the elevation values to calculate slope (maximum rate of change). 

To create the slope map, you will: 

· Specify the input theme 

· Define the properties for the Slope Process (input and output units, type of output, slope classification) 

· Run the Slope Process to create the slope map 
1. Specify the input theme

In the ModelBuilder window, you start the Slope Process Wizard. It prompts you for all the required properties to define the input data, the method for calculating slope, and the output data. First, it prompts you for the input theme from which slope will be derived. The input theme can be project data in ArcView, or derived data created from another process in the model. In this case, you select the DEM Map theme. This theme is elevation data derived from the DEM Conversion Process.
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2. Define the properties for the Slope Process

After choosing the input theme, the Slope wizard prompts you to choose the method for calculating slope. Slope can be calculated in degrees (from 0-90) or percent (from 0 to infinity). You choose Percent.
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The wizard needs to determine the units of the input elevation values to calculate slope correctly. It knows that the map units are in meters. In this case, the elevation theme is derived from a USGS DEM file that measures both horizontal and vertical values in meters, so you choose Meters for the Vertical Units setting.
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3. Define the output theme type

The Slope wizard gives you a choice as to the type of output grid theme: either a continuous grid theme with continuous slope values or a discrete grid theme with slope classes. You choose to create a discrete grid theme because you want to use the output slope map as an input theme in the Weighted Overlay Process. The Weighted Overlay Process requires discrete grid themes as input.
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4. Define the classification table

Since you chose to create a discrete grid theme as output, you now define the slope classes in the classification table. By editing this table, you can customize the slope classes. You want to create six (6) slope classes: 0-10%, 10-20%, 20-30%, 30-40%, 40-50% and one class for all slope values greater than 50% (slopes of 50% or greater have the highest erosion potential). To do this, you delete the slope classes you don't want and edit the labels for the classes. The labels will be used in the output theme's legend.
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5. Define the color scheme, extent, and cell size

You choose the default color scheme, a Red Monochromatic color ramp, for the slope output theme. The steepest slopes will have the darkest red shades. Then, you specify the extent and cell size of the output slope map to be the same as the input elevation theme, DEM Map.
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6. Finish the wizard and add the Slope Process to the model

You document the Slope Process by recording several comments describing your slope classification scheme, the input data source, the type of output, and the larger project to which this process belongs. Finally, you name the output theme and file, and click Finish.
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The Slope Process you defined is added to the model. It is automatically connected to the DEM Conversion Process because it uses the output of that process, DEM Map, as input.
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7. Run the Slope Process

The Slope Process is ready to run. Because it depends on the DEM Conversion Process for its input, running the Slope Process will also run the DEM Conversion Process. To run the Slope Process and create the slope map, you click the Run button. (Alternatively, you could run the model by choosing Run Model on the Model menu or right-clicking the function node.)
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The DEM Process creates the DEM Map theme, then the Slope Process creates the Slope Map theme. Both themes are added in ArcView. You can use the Slope Map theme to determine the areas of greatest erosion potential.
4.2.2 Aspect Process
As part of an erosion analysis model, you want to create an aspect map for a mountainous area. Aspect is the direction a slope faces, such as south, northeast, etc. It determines the amount of sunlight a slope receives and the type of vegetation that grows on it. Slopes with more vegetation may be less prone to erosion. 

You have an elevation theme that you will use as input. The Aspect Process lets you create an output map in either a continuous or discrete grid format (your choice). 

To create the aspect map, you will: 

· Specify the input theme 

· Define the properties for the Aspect Process (type of output, aspect legend, color scheme) 

· Run the Aspect Process to create the aspect map 

In the ModelBuilder window, you start the Aspect Process Wizard. It prompts you for all the required properties to define the input data and the output data. First, it prompts you for the input theme from which aspect will be derived. The input theme can be a continuous grid theme or a discrete grid theme, and it can be project data in ArcView, or derived data (created from another process). In this case, you select the DEM Map theme. This theme is derived data created from the DEM Conversion Process. You see the DEM Map theme in the view.
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2. Define the output theme type and legend
After choosing the input theme, the Aspect wizard prompts you to choose the type of output grid theme you want: either discrete or continuous. You choose continuous because a continuous grid theme represents aspect as gradually changing floating point values. Later on, you can use the output aspect map as an input to the Arithmetic Overlay Process, or convert it to a discrete grid theme using the Reclassification Process, then add it to the Weighted Overlay Process.
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The next wizard panel presents a default classification for the output theme's legend. The classes you create in the legend table are for display purposes only, and do not affect the output cell values. The four compass graphics on the left represent common class ranges for aspect grids. Rather than using the default classification, you want to simplify the output legend, so you click on the second graphic from the top to create a class for each cardinal direction (north, south, east, west).
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3. Define the color scheme

4. Define the extent and cell size

5. Finish the wizard and add the Aspect Process to the model

The Aspect Process you defined is added to the model. The Aspect Process is automatically connected to the DEM Conversion Process because it uses the output of that process, DEM Map, as input. For your erosion model, you also need to determine slope. The same DEM map created by the DEM Process can be used to create slope as well, so you add a Slope Process. The model now contains three processes: DEM Conversion, Aspect, and Slope.
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4.3 Reclassification Process

4.4 Buffer Process

You want to define flood zones around a river and its tributaries. Each year, the river overflows its banks, and every seven to ten years, severe storms cause larger floods. Every 100 years, at least one very large flood can be expected. To determine the areas with the highest flood potential, you use the Buffer Process to create flood zones that represent the yearly, ten-year, and 100-year floods. 

To create yearly, ten-year, and 100-year flood zones, you will: 

· Specify the input theme 

· Define the properties for the Buffer Process (with three buffer zones of different widths) 

· Run the Buffer Process to create the output theme

Step 1: Specify the input theme
In the ModelBuilder window, you start the Buffer Process Wizard. It prompts you for the input theme from which buffer zones will be derived. In this case, you select the Vector Conversion Map theme. This theme is a grid theme converted from a line theme using the Vector Conversion Process. This process has been defined in the model, but has not been run (the grid theme has not been created yet).
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Step 2: Define three buffer zones of different widths

You choose to create a buffer table with three buffers with a default width of 500 meters.
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You edit the buffer table to define the widths of the one-year, ten-year, and 100-year flood zones. The 100-year flood zone is much wider than the one-year or ten-year flood zones. You also change the Labels to describe the three buffer zones.
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Step 3: Define the color scheme, extent, and cell size

Step 4: Finish the wizard and add the Buffer Process to the model

You document the Buffer process by entering comments explaining how you set up the Buffer Process. Finally, you name the output theme and file, and click Finish.
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The Buffer Process you defined is added to the model. It is automatically connected to the Vector Conversion Process because it uses the output theme, Vector Conversion Map, as input.
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Step 5: Run the Buffer Process

The Buffer Process is ready to run. Because it depends on the Vector Conversion Process for its input, running the Buffer Process will also run the Vector Conversion Process. To run the Buffer Process and create the buffer map, you click the Run button. 

The Vector Conversion Process creates the Vector Conversion Map theme, then the Buffer Process creates the Buffer Map theme. Both themes are added in ArcView. You can use the Buffer Map theme to determine the areas with greatest flood potential. 
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4.5 Overlay Processes

4.5.1 Arithmetic Overlay Process
A county is negotiating with two ranches to design a water conservation program for a watershed that crosses county and ranch land. You will use the Arithmetic Overlay Process to create a map that shows which portions of the watershed are on county land and which portions are on each ranch. By assigning unique values for each ranch, the county and the watershed, then adding the values in each theme together, you can create an output theme that identifies the ownership of each portion of the watershed. 
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To create the watershed ownership theme, you will: 

· Specify the two input themes and fields to be overlaid 

· Define the properties for the Arithmetic Overlay Process (values, multipliers, operators, extent, and cell size) 

· Reclassify the output of the Arithmetic Overlay Process to show the watershed ownership 

· Run the model to create the output themes 

Step 1: Add the input themes and fields

You cannot add the Watershed.shp and Ranches.shp themes together because they are not grid themes, so you create two Vector Conversion processes to create the Ranches Grid and the Watershed Grid themes. Now you are ready to create the Arithmetic Overlay process. 

In the ModelBuilder window, you start the Arithmetic Overlay Process Wizard. It displays an empty arithmetic overlay table.
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You click Add Theme and select Ranch Grid from the list of available themes. This theme is derived data from one Vector Conversion Process in the model.
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You add the Watershed Grid theme to the table. The Watershed Grid theme is also derived from a Vector Conversion Process of the Watershed.shp theme. The themes have a default operator of "+", a default multiplier of 1, and default integer values in the arithmetic overlay table.
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Next, you will edit the values for each input value so they will result in unique values when you add the themes.

Step 2: Define the equation in the arithmetic overlay table

The arithmetic overlay table contains the two themes you just added. Now you want to assign values that will uniquely identify the areas inside and outside the watershed that are on Sanford Ranch, Westlake Ranch, and county land. For the watershed theme, you define areas that are inside the watershed as having a value of 1. Areas outside the watershed have a value of 0. You assign each land type a value that is a multiple of 2, so that when the watershed values of 0 or 1 are added, all combinations will be unique. The Sanford Ranch has a value of 2, the Westlake Ranch has a value of 4, and county land has a value of 8. The table below shows all the possibilities. 

	Combinations 
	Ranch Grid value + Watershed Grid value = Output value 

	Sanford Ranch outside watershed 
	2 + 0 = 2 

	Sanford Ranch inside watershed 
	2 + 1 = 3 

	Westlake Ranch outside watershed 
	4 + 0 = 4 

	Westlake Ranch inside watershed 
	4 + 1 = 5 

	County land outside watershed 
	8 + 0 = 8 

	County land inside watershed 
	8 + 1 = 9 


You assign the values in the arithmetic overlay table. You leave the operator as a "+" because you want to add the values in the two input themes. You leave the multiplier as 1. Your equation is: Ranch Grid Value + Watershed Grid Value = Output Value.
[image: image282.png]T

Speciy an Opssor, Mol o cach the o e he Theme Vo, To e a i o Theme Vo,
ik onand 5 e on. To adh an Gpers, ik o, s i dcponn s o o vk, To
2 e ik he A T buon o delte ok e,k b e, e ik e
Belte Tharme e

Inpul Theme [ 0p [ Muliplior | _Inut Field |
1 Sortxd 2
z Wesloke R )
3 County 0
NobATA NoOats o
Wateished Gid |+ 1 Voo I
i aerhed 1
NovATA [T 0

| Add Comstont adiThene | _Ddte Thene
| e





Step 3: Define the classification table and color scheme

The next wizard panel presents a default classification with five equal interval classes. You accept the default because you are going to reclassify the output theme in a Reclassification Process. (Editing the classification table, other than changing the labels and number of classes, is not recommended in the Arithmetic Overlay Process because the class ranges may change automatically if the equation causes the minimum or maximum value to change.) You also accept the default for the color scheme because you will assign meaningful colors in the the Reclassification Process.
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Step 4: Define extent and cell size

Step 5: Finish the wizard and add the Arithmetic Overlay Process to the model

You document the Arithmetic Overlay Process by recording descriptive comments. Finally, you name the output theme and file, and click Finish.
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The Arithmetic Overlay Process you defined is added to the model. It is automatically connected to the two Vector Conversion Processes that create the Ranch Grid and Watershed Grid themes.
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Step 6: Reclassify the results of the Arithmetic Overlay Process

You reclassify the output theme of the Arithmetic Overlay Process into classes for each land and watershed combination. You also enter labels and choose a new color scheme. The default color scheme for the Reclassification Process is a red monochrome color ramp. You define appropriate colors, brown tones for land outside the watershed, and blue tones for land inside the watershed.
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You accept the defaults for the rest of the Reclassification Process, then finish the wizard. The Reclassification Process is added to the model.
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Step 7: Run the model
4.5.2 Weighted Overlay Process

As part of a deer habitat analysis in the Rocky Mountains, you want to find areas away from roads and close to water with vegetation that deer prefer. You start with three vector themes: Covertype (includes vegetation), Hydro (lakes and streams), and Roads.
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You convert these themes to grid themes using the Vector Conversion Process. Then you create buffer zones (200-meter, 500-meter, and 1000-meter) around water features and roads using the Buffer Process. Deer prefer zones closest to water and farthest from roads.
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Now you are ready to overlay the cover types with the buffered water features and roads to determine which areas have the best deer habitat. To do this, you will use the Weighted Overlay Process. 

The Weighted Overlay Process lets you adjust the cell values of the three themes to a common evaluation scale of deer habitat suitability, then assign a percent influence (weight) to each theme based on its importance to the model. For example, the cover type is more important in deer habitat analysis than proximity to water features or distance from roads. Once the cell values are adjusted and the weights are assigned, the Weighted Overlay Process multiplies the cell values in each theme by the weight assigned to that theme, then adds the cell values for all three themes together to create the output theme. 

To create the weighted overlay theme, you will: 

· Specify the input themes and fields to be overlaid 

· Define the properties for the Weighted Overlay Process (scale values, percent influence, legend color scheme, extent, and cell size) 

· Run the Weighted Overlay Process to create the output theme 

Step 1: Specify the evaluation scale
In the ModelBuilder window, you start the Weighted Overlay Process Wizard. It prompts you to choose the evaluation scale. The evaluation scale allows you to translate the input values in the three themes to a common scale of deer habitat suitability. You create a custom evaluation scale (1 To 4) by setting the From value to 1, the To value to 4, and the By value to 1.
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Step 2: Choose the input themes and fields to be added

An empty weighted overlay table displays. This is where you will do the work of assigning values and weights to the input theme.
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You click the Add Theme button and select Covertype Grid from the input theme list in the popup window. It is derived data from the Vector Conversion Process, which converts the original Covertype (polygon) theme to a grid theme. There is only one field to choose from, the Value field.
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The input theme is added to the weighted overlay table. You see the Input Theme name, the %Inf (Percent Influence, not yet assigned), the Input Field and each unique value in that field, the Input Label assigned to each value, and the Scale Value (not yet assigned). Before updating this table, you will add the other two themes you want to overlay.
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At the bottom of the weighted overlay table, you click the Add Theme button and choose the Buffer Hydro theme. It is derived data from the Buffer Process, which creates 3 buffers (200-meter, 500-meter, and 1000-meter) around water features. There is only one field to choose from, the Value field.
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The Buffer Hydro theme is added to the weighted overlay table. You click the Add Theme button again to add the third theme, Buffer Roads. Now all three themes are added to the weighted overlay table.
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Step 3: Define the properties for the weighted overlay table

You are ready to edit the weighted overlay table. To begin, you assign a Scale Value to each Existing Class Value in the first theme, Covertype Grid, according to the values in this list: 

	Input Label 
	Scale Value 

	Alder 
	3 

	Aspen 
	4 

	Blue Spruce 
	4 

	Bog 
	3 

	Disturbance/Artificial 
	2 

	Douglas Fir 
	4 

	Engleman/Subalpine 
	4 

	Grasses 
	4 

	Grasses-wet 
	4 

	Limber Pine 
	2 

	Lodgepole Pine 
	3 

	Narrowleaf Cottonwood 
	4 

	Open Water 
	Restricted 

	Open Water - River 
	Restricted 

	Ponderosa Pine 
	2 

	Rock 
	Restricted 

	Sandbar 
	Restricted 

	Shrub 
	3 

	Snow/Icefield 
	Restricted 

	To Be Updated 
	Restricted 

	Tundra 
	1 

	Willows 
	3 


Preferred cover types are assigned a Scale Value of 4; undesirable cover types are assigned a Scale Value of 1; unvegetated cover types are assigned a Scale Value of Restricted and will not be considered in this model. After the Scale Values are set, you assign a percent influence (%Inf) value of 50% to this theme because cover type is the most important variable in defining deer habitat. 
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Next, you will assign Scale Values and a percent influence (%Inf) to the other two themes. 
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Notice that a Scale Value of 4 (most suitable for deer habitat) is assigned to cells in the Buffer Hydro theme that are within 200 meters of water, and to cells in the Buffer Roads theme that are greater than 1000 meters from roads (the No Data cells outside the buffer). The Buffer Hydro theme also has a higher percent influence (%Inf) of 30% because proximity to water is more important to the model than distance from roads. Also notice that the Sum of influences equals 100%.
Step 4: Define the output theme color, extent, and cell size

Step 5: Document the process and finish the wizard

The Weighted Overlay Process you defined is added to the model. It is automatically connected to the Vector Conversion and Buffer Processes because it uses the output of these processes as input.
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Step 6: Run the Weighted Overlay Process
4.6 Standalone nodes

Part 5: Avenue scripts
The links below are for sample Avenue scripts that can automate starting ModelBuilder and running models. You can copy a script from the help window by highlighting it, pressing Ctrl+C to copy it, and pressing Ctrl+V to paste it in the Avenue script window. See the ArcView Help to learn how to assign a script to a button on the view interface.

Open model

The OpenModel.ave Avenue script starts the ModelBuilder window and opens a specific model. Replace the "c:\temp\model1\model1.xmd" string with the full path to your model. 

'Program: OpenModel.ave
'
'Comments: 
'
'This program assumes the active doc is a view.
'Setting the model display view is optional.
'If you do not set the model display view, a new view will be created when you run the model with ModelBuilder.

vwActive = Av.GetActiveDoc 
sViewName = vwActive.GetName 
sModelFile = "c:\temp\model1\model1.xmd" 

av.run("MDDisplay.SetViewName", {sViewName}) 
av.run("MDBuilder.Start", {sModelFile})

Run model

The RunModel.ave Avenue script runs a specific model in ModelBuilder. Replace the "c:\temp\model1\model1.xmd" string with the full path to your model. 

The ModelBuilder window does not need to be open for this script to run the model. However, make sure you run the entire model the last time you use it in ModelBuilder (Select Run Entire Model from the Model menu). This will save the model with a complete run node list. 

'Program: RunModel.ave
'
'Comments: 
'
'This program assumes the active doc is a view.
'If sAddToView = "FALSE", the derived themes will not be added to a view.
'If sAddToView = "TRUE", the derived themes will be added to a view.

sAddToView = "TRUE" 

'The following code sets the view which will contain the derived data after the model is run.
'This code applies only if sAddToView = "TRUE".
'This code is optional - if you do not set the view and sAddToView = "TRUE", a new view will be created.

vwActive = Av.GetActiveDoc 
sViewName = vwActive.GetName
av.run("MDDisplay.SetViewName", {sViewName}) 

'The following code establishes the location of the model and log file and runs the model.
'MDApp.Run will return True if the model run completed without error.
'MDApp.Run will return False if the model run had an error.
'See the log file for error messages.

sModelFile = "c:\temp\model1\model1.xmd"
sLogFile = "c:\temp\model1\model1.log"
bSuccess = av.run("MDApp.Run",{sModelFile,sAddToView,sLogFile})

